The University of Mississippi
Department of Physics and Astromony
General Physics Laboratory Manual
Physics 223 - Physics 224

2018 Edition
Dan Miller

Contents
1

Measurement & Analysis . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

5

2

Motion: Uniform and Non-Uniform . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

11

3

Vector Addition . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

15

4

Projectile Motion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

21

5

Newton’s Second Law . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

27

6

Coefficients of Friction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

33

7

Conservation of Energy and Linear Momentum . . . . . . . . . . . . . . . . . . . . . . . . . . .

39

8

Torques and Rotational Motion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

45

9

Moments of Inertia . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

49

10 Archimedes’ Principle

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

11 Simple Harmonic Motion

53

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

57

12 Speed of Sound in Air . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

61

13 Electrostatics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

65

14 Electric Fields and Potentials . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

71

15 Ohm’s Law . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

77

16 Series and Parallel Circuits . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

83

17 Kirchhoff ’s Laws for Circuits . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

89

18 Earth’s Magnetic Field . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

95

19 The Current Balance . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 101
20 Exponentials and Oscilloscopes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 107
21 Geometric Optics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 117
22 Thin Lenses . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 125
23 Wave Optics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 133
A

Math Review . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 139

B

Measurement and Uncertainty . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 149

C

Computers and Software . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 153

2

3

List of Tables
1.1

Densities of Selected Materials . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

9

13.1 Electrostatic Series . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67
14.1 Electric Quantities and Units . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75
15.1 Resistor Color Code Values . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 78
15.2 Effect of Electric Current on the Body . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 81
19.1 Wire Loops Effective Lengths . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 104

4

Experiment 1: Measurement & Analysis

Figure 1.1: Measurement Materials

EQUIPMENT
1-Meter Stick
Digital Balance
500 g, 1 kg, 2 kg Stamped Masses
Metal Cylinder
Digital Caliper
(10) Cylinders (Plastic, Wood)
String
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Experiment 1: Measurement & Analysis
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Advance Reading
Text: Giancoli sections 1-4 to 1-6 SI units for fundamental quantities, prefixes, significant figures, converting units, dimensional analysis. Lab Manual: Appendix B - Measurement and Uncertainty.
Objective
Enhance measurement and graphing skills; introduce
error analysis.

All measurements have uncertainty; they can only be
so precise. The precision of the measuring instrument
used determines the uncertainty of a measurement.
The size of the smallest scale division (the resolution) of an instrument determines the uncertainty
of measurements obtained with that instrument. Uncertainty, δ (Greek letter delta), is either equal to the
resolution or equal to 12 the resolution of the measuring instrument, depending on how the instrument is
designed.

Theory

Digital Instrument:

δ = the resolution

The fundamental quantities of mechanics are length,
mass, and time. The SI units for these quantities are
the meter (m), kilogram (kg), and second (s), respectively. All other mechanical quantities can be stated
in terms of these quantities. For example, the unit of
force in the SI system is the newton (N):

Analog Instrument:

δ=

1
2

the resolution

In terms of fundamental quantities, a newton is
[mass]·[length]/[time2 ].

Analog instruments, such as rulers, are read by eye
and can be estimated within ± half of a “tick” mark.
Digital instruments can be as imprecise as a full digit
in either direction. A digital reading of “5.2 g” might
be obtained for masses ranging between (5.100...1) g
and (5.2999...) g, so their uncertainty is fully equal to
the resolution of the instrument.

In this experiment, you will use a variety of instruments to measure the fundamental quantities of length,
mass, and time (see Fig. 1.1). You will then use these
measurements to calculate other quantities and perform error analysis (refer to Appendix B).

Measurements of time on a typical analog clock or
watch are considered digital, due to the manner in
which they are read; the second hand moves in increments of full seconds, and an estimation cannot be
made between seconds.

1 N = 1 kg·m/s2 .

Prelab 1: Measurement & Instruments
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Name:

1. What are the fundamental quantities of mechanics, their symbols, and their respective units? (25 pts)

2. State the symbol and value for the following prefixes: (5 pts ea.)
Prefix

Symbol

Value

mega

kilo

centi

milli

micro

3. When comparing experimental values, what determines the correct equation to use? (Hint: Always read the
Advance Reading material before you attempt the Prelab; this information is located in Appendix B.) (20 pts)

4. Convert the following: (10 pts ea.)

• 1.00 in. =

cm

• 6.10 in. =

cm

• 4 cm2 =

m2
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PROCEDURE
PART 1: Estimating Length

15. Identify the metal in the cylinder using the density
chart (Table 1.1, Page 9). Compare your value of
density to the accepted value. What is your percent
error?

1. Close your eyes and hold your hands about 50 cm
apart on the table. Have you partner measure the
actual distance between your hands using a meter
stick.

PART 4: Graphing

2. Record this value in the table provided. What is
the resolution of the ruler? Use this to determine
the uncertainty in your measurement.

16. Measure diameter and circumference of the 10 plastic and/or wood cylinders provided. Use a piece of
string for measuring circumference.

3. Repeat for 100 cm.

17. Graph C vs. D on the computer. Open the Graphical Analysis software provided and enter your data
in the columns on the left.

4. Have your lab partner estimate 50 cm and 100 cm
in the same way.
5. Calculate your percent error for each estimate. How
much did your measured value differ from what you
expected? How large is that difference compared to
the length you expected? (50 cm, 100 cm) Percent
error can be calculated as follows: (Eq. B.1)
% error =

|measured−expected|
expected

× 100

PART 2: Estimating Mass
6. Pick up several of the stamped masses on the lab
table to get a sense of their weight.
7. Close your eyes and have your partner hand you
some mass. Estimate its weight in grams and record
it in the table provided.
8. Estimate again as your partner hands you a second
amount of mass.
9. Give your partner two different amounts of mass to
estimate in the same way.

PART 3: Measuring Density
10. Plug in the digital balance and zero it.
11. Measure the mass of the metal cylinder provided.
What is the resolution of the balance? Use this to
determine the measurement uncertainty.
12. Measure the height and diameter of the metal cylinder using the vernier caliper.
13. Calculate the volume of the cylinder. This is equal
to the area of the base times the height. Show your
work.
14. What is the density, ρ, of the metal cylinder?

18. Fit the data with a linear regression line. Select
from the drop-down menu bar: Analyze ⇒ Linear
Fit
19. Determine the slope of the best-fit line from the information box provided on-screen.

Experiment 1: Measurement & Analysis

Material
Solids
Metal:
Aluminum
Stainless Steel
Brass
Bronze
Copper
Lead
Mercury
Rock:
Granite
Slate
Diamond
Garnet
Corundum
Wood:
Pine (Yellow)
Oak
Ebony
Misc.:
Ice
Bone
Chalk
Glass (Lead)
Fluids
Atmosphere (STP)
Water (20◦ C)
Water (0◦ C)
Mercury (20◦ C)

9

Density
(g/cm3 )

2.70
7.8
8.44 - 8.75
8.74 - 8.89
8.96
11.3
13.5336
2.64 - 2.76
2.6 - 3.3
3.51
3.15 - 4.3
3.9 - 4.0
0.37 - 0.60
0.60 - 0.90
1.11 - 1.33
0.917
1.7 - 2.0
1.9 - 2.8
3-4

0.001225
0.99821
0.99984
13.546

Table 1.1: Density of Selected Materials
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Experiment 2: Motion: Uniform and
Non-Uniform

Figure 2.1: Experimental Setup
EQUIPMENT
Lab Pro Interface and USB Chord
Motion Detector
Power Supply
Basketball
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Experiment 2: Motion: Uniform and Non-Uniform

Advance Reading
Text: Uniform motion, non-uniform motion, graphical representation of motion, position, displacement,
distance, velocity, speed, acceleration, kinematic equations, slope of a line.
Lab Manual:
Appendix C: COMPUTERS and SOFTWARE
Objective
To qualitatively analyze the kinematic equations by
graphing a student, then objects, in motion; to enhance graph analysis and graphing skills.
Theory
Kinematics is the description of how objects move. An
effective method of describing motion is to plot graphs
of distance, velocity, and acceleration vs. time. Using
a motion detector and computer software, your motion
as you move around the room will be graphed. Qualitative analysis of these graphs will help your develop
a better understanding of the concepts of kinematics
and enhance your graph analysis skills.

Definition of terms:
Distance is the length of the path traveled.
Displacement is the change in position.
Example:
Your friend lives on the north side of Memphis, 100
miles from Ole Miss. You visit your friend and return
to Ole Miss. Let’s assume towards Memphis is the
positive direction of our coordinate system.
Your traveled a distance of 200 miles.
Your displacement from Ole Miss to Memphis was
+100 miles.
Your displacement from Memphis to Ole Miss was
−100 miles.
Your total displacement was 0 miles.
Speed is the distance traveled/total time traveled
Velocity is displacement/time
Example:
You drove for 2 hours to visit your friend and 2 hours
on the return trip to Ole Miss.
Your average speed was 50 mph.
Your average velocity from Ole Miss to Memphis was
+50 mph.
Your average velocity from Memphis to Ole Miss was
−50 mph.
Your average velocity for the entire trip was 0 mph.
Acceleration is the change in velocity/change in
time. It can be either positive or negative.
Note that linear graphs (streaight lines) are analyzed
with the slope-intercept equation of a line:
y = mx + b

(2.1)

Prelab 2: Motion: Uniform and Non-Uniform
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Name:
Sketch Cartesian coordinate systems on the back of this sheet as needed. The origin should be (0, 0); no scale is
necessary. Sketch means you don’t need a ruler, etc., but a curve should not look like a straight line, or vice versa.
All lines/curves should end with an arrowhead.
1. Sketch a d vs. t (distance vs. time) graph for each of the following situations: (25 pts)
(a) An object at rest
(b) An object moving in a positive direction with a constant speed
(c) An object moving in a negative direction with a constant speed
(d) An object that is accelerating in a positive direction, starting from rest
2. Sketch the v vs. t (velocity vs. time) graph for each of the situations described above. (25 pts)

3. What is the shape of a velocity vs. time graph for any object that has a constant acceleration? (20 pts)

4. Consider a ball thrown straight up. It goes up, then falls down. (Start by defining the coordinate system. Is up
or down the positive y direction?) What is the acceleration of the ball on the way up? What is the acceleration
when it reaches its highest point? Is the acceleration positive or negative? What is the acceleration of the ball on
the way down? Is the acceleration positive or negative? (25 pts)

5. What are the objectives of this experiment? (5 pts)

Experiment 2: Motion: Uniform and Non-Uniform
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PROCEDURE
PART 1: Position vs. Time

1. Turn on your computer; connect the Lab Pro and
motion detector device.
2. Open the Logger Pro software.
3. Find and open the file title “01a Graph matching.”
Applications ⇒ Logger Pro 3 ⇒ Experiments ⇒
Physics with Vernier ⇒ 01a Graph Matching
4. Stand in front of the motion detector, with plenty of
room to walk in front of it. Push “Collect” to begin
collecting data and move towards/away from the
detector however you like. Watch your measured
distance as it is recorded onscreen; try to adjust it
with your motion. Remain at least 0.5 meters from
the motion detector at all times.
5. Print this graph with your name on it; select File
⇒ Printing Options and enter your own name.
6. Have your partner create his or her own graph and
print it.
PART 2: Position vs. Time Graph Matching
7. Open 01b and choose one partner to reproduce it.
Begin collecting data and match the position graph
as closely as possible with your own motion.
8. Print the graph with your name on it once you have
achieved a satisfactory graph.
9. Have your lab partner match 01c similarly and print
the result.
PART 3: Velocity vs. Time Graph Matching
10. Open the file 01d. Push “Collect” and match the
graph with your own velocity as closely as possible.
Print the resulting graph.
11. Similarly, have your lab partner attempt to match
01e and print it.
PART 4: Bouncing Ball
12. Open the file titled “02 Ball.”
13. Hold the motion detector at shoulder height, pointing down to capture the motion of the ball.
14. Drop the ball beneath it and record its motion
through four full bounces.
15. Adjust the scale to show exactly four
bounces on the screen.

Figure 2.2: Position and velocity graphs of a bouncing ball. Note that the shape of the bounce appears
to be inverted.

16. On the velocity graph, click and drag to select a
section that appears to be a straight line with a
positive slope (i.e. the ball is in the air). Use the
Linear Fit button to obtain a linear fit for this segment of the graph. Repeat for each bounce, for a
total of four segments. Print a copy for each lab
partner, labeled with both of your names.

17. Use the Examine and Tangent buttons to determine
position, slope, and time on both the position and
velocity graphs. Take these measurements at four
locations: traveling upwards, near the top, traveling downwards, and near the bottom (indicated in
Fig. 2.2).

Experiment 3: Vector Addition

Figure 3.1: Force Table
EQUIPMENT
Force Table
(4) Pulleys
(4) Mass Hangers
Masses
Level (TA’s Table)
(2) Protractors
(2) Rulers
(4) Colored Pencils (bold colors)
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Advance Reading

Tail-to-Head Method

Text: Motion in one and two dimensions, vectors and
vector addition.

Vectors can be added together graphically by drawing
them end-to-end. A vector can be moved to any location; so long as its magnitude and orientation are not
changed, it remains the same vector. When adding
vectors, the order in which the vectors are added does
not change the resultant.

Objective
The objective of this lab is add vectors using both the
tail-to-head method and the component method and
to verify the results using a force table.
Theory
A scalar quantity is a number that has only a magnitude. When scalar quantities are added together (e.g.,
prices), the result is a sum.
Vectors are quantities that have both magnitude and
direction; specific methods of addition are required.
When vector quantities are added, the result is a resultant.
For example, if you walk 1 mile north, then 1 mile east,
you will walk a total distance of 2 miles (distance is a
scalar quantity). Displacement, a vector, involves both
distance and direction.
√ So the same 2 mile walk results
in a displacement of 2 miles northeast of where you
began (≈ 1.41 miles, northeast of your starting position).

• Draw each vector on a coordinate system; begin
each from the origin.
• Choose any vector drawn to be the first vector.
• Choose a second vector and redraw it, beginning
from the end of the first.
• Repeat, adding as many vectors as are desired to
the end of the “train” of vectors.
• The resultant is a vector that begins at the origin
and ends at the tip of the last vector drawn. It is
the shortest distance between the beginning and
the end of the path created.

A negative vector has the same length as the corresponding positive vector, but with the opposite direction. Making a vector negative can be accomplished
either by changing the sign of the magnitude or by
simply adjusting the direction by 180◦ .
~ = 5 N 100◦
V

~ = -5 N 100◦
-V
or
~
-V = 5 N 280◦

~1 +F
~2 = F
~2 +F
~1 = R
~
F
Figure 3.2: Adding 2 Vectors, Tail-to-Head
The tail-to-head method is often useful when working
problems. A quick sketch, rather than measurements,
can help verify your solutions.

Experiment 3: Vector Addition
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Component Method
To add vectors by components, calculate how far each
vector extends in each dimension. The lengths of the
x- and y-components of a vector depend on the length
of the vector and the sine or cosine of its direction, θ:

sinθ =

F 1y
F1

cosθ =

~ can be converted back into polar
The components of R
form (R, θ) using the Pythagorean theorem (Eq. 3.6)
and the tangent function (Eq. 3.3):
q
~ = R = R2 + R2
(3.6)
|R|
x
y
θ = tan−1

F 1x
F1

Use algebra to solve for each component, F 1x and F 1y ,
from these equations.

~ 1 |cosθ
F 1x = | F

(3.1)

~ 1 |sinθ
F 1y = | F


F 1y
−1
θ = tan
F 1x

(3.2)



Ry
Rx



(3.7)

Note: Verify the quadrant! A calculator will return
only one of two possible angles (Eq. 3.7). To verify
the quadrant, determine if Rx , Ry are positive or negative. If your calculation puts the resultant in quadrant I, but Rx and Ry are both negative, it must be in
quadrant III; simply add 180◦ to the angle.
Force Table Verification

(3.3)

We will use a force table to verify our results of vector
addition and gain a hands-on perspective. The force
table is a circular steel disc with angles 0◦ to 360◦ inscribed on the edge (refer to Figure 3.1).
As noted above, when adding vectors, a resultant vector is determined. To balance the force table, however,
a force that is equal in magnitude but opposite in di~
rection must be used. This force is the equilibrant, E.
~
~
E = −R.
For example, when a 10.0 N force at 0◦ and a 10.0 N
force at 90◦ are added, the resultant force has a magnitude of 14.1 N at 45◦ . The equilibrant force has the
same magnitude, but the direction is 180◦ +45◦ = 225◦ .
The equilibrant must be used to balance the two 10.0 N
forces.

Figure 3.3
When each vector is broken into components, add the
x-components of each vector:
n
X

F i x = Rx

(3.4)

i=1

Then add all of the y-components:
n
X

F i y = Ry

(3.5)

i=1

The sums are the x- and y-components of the resultant
~
vector, R.

Prelab 3: Vector Addition
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Name:
1. What is a vector? (10 pts)

2. Name a vector quantity and its magnitude. (10 pts)

3. What is a scalar quantity? Give two examples. (10 pts)

4. What is the equilibrant? (10 pts)

For Questions 5, 6, and 7, use the following values:
~ = 5.0 N at 135.0◦
A

~ = 6.0 N at 270.0◦
B

If you get the same answer for Questions 5 and 6, ask for help!

~ and B
~ (i.e., R
~ =A
~ + B).
~ (20 pts)
5. Using the component method, add vectors A

~ and −B
~ (i.e., R
~ =A
~ − B).
~ (20 pts)
6. Using the component method, add vectors A

~ and B
~ (R
~ = A
~ + B),
~ on the back of this sheet; rulers and
7. Using the Tail-to-Head method, add vectors A
protractors will be provided in the physics building. Let 2.0 cm = 1.0 N. (20 pts)

Prelab 3: Vector Addition
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10

5

0

-5

-10
-10

-5

0

5

10
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PROCEDURE
PART 1: Tail-to-Head Method
1. Your TA will provide you with a set of three force
vectors, record them in the table to the right. Let
1.00 N = 2.00 cm on graph paper.
2. Using a ruler and a protractor, draw the three vectors on the graph paper provided, starting each one
from the origin. You should place the origin near
the center of the page. Use different colored pencils
for each vector.

14. Calculate your accuracy against the theoretical
equilibrant. Show your work.
PART 3: Vector Subtraction
~ and E
~ are given by your TA. Record
15. Vectors D
them in the table provided.
~ − E.
~ It may help you to
16. Calculate the resultant, D
draw a sketch.
17. Find the equilibrant.

3. Label the three force vectors.
~ and B
~ graphically: Draw
4. Add together vectors A
~
vector B again, beginning from the tip (or “head”)
~
of vector A.
~ to the first two: Re5. Next, add the third vector, C,
~
draw it, beginning from the tip of B.
~ from the origin to the tip of
6. Draw the resultant, R,
~ When the three forces A,
~
the last vector drawn, C.
~ and C
~ act together, they behave as though they
B,
~
were only one force, R.
~ Include uncertainty in your
7. Measure and record R.
~
measurement of |R| and θ.
8. Record the equilibrant that balances the three
forces. Note that this has the same magnitude as
~
R.
PART 2: Force Table
9. Use the level to level the force table.
10. Set three pulleys on the force table in the magni~ B,
~ and C.
~ Note: the mass
tude and direction of A,
hanger has its own mass. Let 1.00 N = 100 g on the
force table.
11. Add a fourth vector to equalize the forces. This
equilibrant force can have any magnitude and direction; you may use your equilibrant from Step 8
as a guide.
12. Have your TA pull the pin from your force table to
see if ΣF = 0.
13. If the forces are unbalanced, adjust the magnitude
and direction of the equilibrant. When they are balanced, the fourth vector is your experimental equilibrant.

QUESTIONS
~ (R and θ) for each
1. Compare the two methods for R
set of vectors.
2. Consider six vectors that are added tail-to-head,
ending up where they started from. What is the
~
magnitude of R?

Experiment 4: Projectile Motion

Figure 4.1: Ballistic Pendulum (Spring Gun)
EQUIPMENT
Pasco Ballistic Pendulum (Spring Gun)
2-Meter Stick
Meter Stick
Ruler
Plumb Bob

Carbon Paper
Target Paper
Launch Platform & C-clamps
Wall Guards

21
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Advance Reading
Text: Motion in two dimensions (2-D), projectile motion, kinematic equations.
Lab Manual: Appendix B, Appendix A.
Objective
To measure the initial velocity of a projectile when
fired from a spring gun and to predict the landing point
when the projectile is fired at a non-zero angle of elevation.
Theory
Projectile motion is an example of motion with constant acceleration when air resistance is ignored. An
object becomes a projectile at the very instant it is released (fired, kicked) and is influenced only by gravity.
The x- and y-components of a projectile’s motion are
independent, connected only by time of flight, t. Consider two objects at the same initial elevation. One
object is launched at an angle θ = 0◦ at the same moment the second object is dropped. The two objects
will land at the same time. This allows the two dimensions to be considered separately.
To predict where a projectile will land, one must know
the object’s starting position, ~r0 , initial velocity, ~v0 ,
and the acceleration it experiences, ~a . Position as a
function of time is then described as:
1
~r (t) = ~r0 + ~v0 t + ~a t2
2

(4.1)

Eq. 4.1 is a vector equation; it can be resolved into xand y-components:
1
(4.2)
x = x 0 + v 0 x t + a x t2
2
1
y = y 0 + v 0 y t + a y t2
2

(4.3)

Velocity changes constantly in projectile motion.
While horizontal acceleration is zero for the purposes
of this experiment, the vertical component of a projectile’s velocity can be described as follows, with ay = g:
v y = v 0y + a y t

(4.4)

These are the kinematic equations for constant acceleration. Taken together, they describe the motion
of projectiles and other constant-acceleration systems.

Part 2 of this experiment involves finding the components (v0x and v0y ) of the velocity of a projectile fired at
above the horizontal (θ > 0◦ ). To determine the components of an initial velocity vector, refer to Eq. 3.1
and Eq. 3.2 of Experiment 3: Vector Addition.
When measuring the change in position for the projectile in this experiment, measure from the bottom of
the ball to the floor for ∆y, and measure the end of
the rod from which it is fired to where it lands for ∆x.
The ballistic pendulum (spring gun) should be held
firmly in place when fired to prevent loss of momentum.

Prelab 4: Projectile Motion
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Name:
1. What is projectile motion? (15 pts)

2. Find the initial velocity, v0 , of a ball rolling off the table in the figure below. The launch position is the origin of
the coordinate system, positive directions as specified. (25 pts)

3. For a ball shot with an initial speed of 8.0 m/s at θ0 = 30◦ , find v0x and v0y . Always write the algebraic equations
first, then write the equations with values inserted. (20 pts)

4. Given the information in Question 3, y = −0.8 m, use the quadratic formula to solve for t1 and t2 . Note: It is
unlikely that you will finish the experiment if you are not able to solve this type of quadratic equation. (20 pts)
y = y0 + v0y t + .5ay t2

(Continued on back page)
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Figure 4.2: The Trajectory
On May 5, 1961, only 23 days after Yuri Gagarin of the then-Soviet Union became the first person
in space, NASA astronaut Alan Shepard launched at 9:34 a.m. EDT aboard his Freedom 7 capsule,
powered by a Redstone booster, to become the first American in space. His historic flight lasted
15 minutes, 28 seconds. Image Credit: NASA
6. Calculate the initial velocity in m/s, ignoring air resistance. Show work. (20 pts)
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Figure 4.3: Projectile Motion. The trajectory (path) is a parabola.
PROCEDURE
PART 1: Horizontal Launch (θ0 = 0◦ )
1. Align the back edge of the spring gun with the back
edge of the table. The initial position of the projectile is defined to be the origin of your coordinate
system, as shown above in Fig. 4.3. Measure ∆y.
2. Calculate the time of flight, t.
3. Read this step and the next step before proceeding.
When the spring gun is fired for the first time, you
will need to note where the ball lands. This is the
location for your target. The target is a sheet of
white paper taped to the floor with a sheet of carbon paper placed on top. Do not tape the carbon
paper.
4. Place the wastebasket against the wall where you
expect the ball to hit. Do not allow the ball to hit
the wall. When the flight path is secure, cock the
spring gun to the third detent, then fire to determine the target location. Place the target.

5. Place the wastebasket against the wall, in the line
of fire; do not allow the ball to hit the bare wall.
Fire the spring gun once and measure x.
6. Determine v0 .
7. Record your value for v0 in the table.
8. Fire the spring gun 5 more times. Measure and
record xi for each trial. Remember that xi means
x1 , x2 , x3 , etc.
9. Calculate the average displacement, xavg , for all 6
trials.
10. Use xavg to calculate v0−avg .
11. Record your value for v0−avg in the table.
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PART 2: Inclined Launch (θ0 > 0◦ )
12. Elevate the front of your spring gun by removing the
launcher and reattaching it to the vertical mount
slots at an angle. Be certain that the back edge of
the spring gun is aligned with the back edge of the
table. Adjust the wastebasket at the wall if necessary.
13. Measure the angle by holding the string of the
plumb bob at the corner of the quarter sphere on
the launcher and reading the angle where the string
crosses the outer edge. Remeasure y0 to the lowest
point of the ball outline at the launch position diagram on the launcher. Record these values in your
table.
14. Use the kinematic equations and the quadratic formula to calculate the displacement of the ball when
fired from this angle and height. Note that v0y is
not equal to 0.0 m/s.
15. Place your target at the predicted location. Fire
the spring gun a total of six times.
16. Determine xavg .
17. Compare the theoretical and experimental values of
x for Part 2. If the values are substantially different,
check your calculations or measurements.

QUESTIONS
1. If a ball has twice the mass but the same initial velocity, what effect would this have on its displacement (neglect air resistance)?
2. Consider the following statement: When a rifle is
fired horizontally, the bullet leaves the barrel and
doesnt drop at all for the first 75 meters of flight.
Is this statement true?
3. What is the acceleration of a projectile fired vertically upwards? Is it positive or negative? Sketch
your coordinate system.
4. What is the acceleration of a projectile fired vertically downwards? Is it positive or negative? Use the
same coordinate system you used for Question 3.
5. Determine the standard deviation, σ, for xi for
Part 1. (Refer to Appendix B)
6. Determine σ for xi for Part 2.

Experiment 5: Newton’s Second Law

Figure 5.1: Modified Atwood’s Machine Setup
EQUIPMENT
Low-Friction Cart
Pulley and String
Triple-Beam Balance
Digital Balance
Stopwatch
Meter Stick
Mass Hanger
(1) 10 g Mass
(2) 20 g Masses
(1) 50 g Mass
Paper Clips (small masses)
Plumb Bob
Wastebasket

Figure 5.2: Note: String from cart to pulley must be
horizontal and aligned with the pulley.
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FREE-BODY DIAGRAM SOLUTION METHOD: INSTRUCTIONS
Step 1: Sketch the problem/situation and specify the coordinate system for each object in your system.
Step 2: Draw all forces (arrows that represent these vectors) acting on each object in the system you are investigating.
All forces should extend away from the object in the direction of the force. Remember that the length of the arrow
is an indication of the magnitude of the force.

~ = m~a = 0.0 N).
Figure 5.3: Free-Body Diagram of Modified Atwood’s Machine (Example for ~v constant, ΣF

~ = m~a ) in component form (ΣFx = max and ΣFy = may ) for each object in
Step 3: Write Newton’s 2nd Law (ΣF
the system. For this example, mA and mB :

mA : ΣFAx = mA aAx
ΣFAy = mA aAy

mB : ΣFBx = mB aBx
ΣFBy = mB aBy

Step 4:
Refer to your diagram to sum the forces for each object as instructed by Sir Isaac Newton. For this example:

ΣFAx = mA aAx = T − Ff

ΣFBx = mB aBx = 0.0 N

ΣFAy = mA aAy = FN − mA g = 0.0 N

ΣFBy = mB aBy = T − mB g

(aAy : Constant velocity means this acceleration equals
0.0 m/s2 )

(mB : No forces acting in the horizontal direction.)
(Note that since mA and mB are connected and moving together, T is the same for each object, and aAx =
−aBy .)

Step 5:
Write the known quantities. Write the question.
Always write equations algebraically first, then insert the known values.
Now do the math! That’s all there is to it.

Experiment 5: Newton’s Second Law
Advance Reading
Text: Newton’s Second Law, Atwood’s Machine, acceleration, velocity, displacement, vectors.
Lab Manual: Appendix C
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Once Ff has been counteracted, any additional mass
will be directly related to the acceleration of the system as in Eq. 5.1. The added mass, mB , exerts a force
equal to its weight on the cart/mass system.
When the cart is accelerating, deriving T and a of the
cart is more involved. The relevant equations for this
experiment are provided:

Objective
The objective of this lab is to explore and analyze the
relationship between force, mass, and acceleration.
Theory
According to Newton’s Second Law, the acceleration,
~a , of a body is directly proportional to the vector sum
~ applied to the body:
of the forces, ΣF,

mB · g
mA + mB + mf

(5.3)

mA · mB · g
+ mf · g
mA + mB + mf

(5.4)

a=
T =

(5.1)

We will compare the acceleration from Eq. 5.3 to the
acceleration obtained from the kinematic equations for
constant acceleration (Page 22, Experiment 4).

The experimental configuration for this experiment is
a variation of Atwood’s machine (Fig. 5.2, Fig. C.6).

In this experiment, acceleration will be found experimentally tracking the cart’s motion across a set distance. The time of travel will be carefully measured
using a stopwatch.

~ = m~a
ΣF
where m is the mass of the body.

A force T (tension) will be applied to the cart, mA , by
means of a string with an attached mass, mB . If one
can ignore the force of friction acting on the cart, then
Eq. 5.1 in the direction of motion simplifies to:

ΣFAx = mA aAx = T

(5.2)

Thus, if the mass of the cart is doubled while T is
held constant, the acceleration of the cart is halved
(Part 1). Correspondingly, if T is doubled while mA is
held constant, the acceleration of the cart is doubled
(Part 2).
This analysis assumes a frictionless environment. For
simplicity, Ff will be counterbalanced by a small mass,
mf , hanged from one end of the system. When the
weight of mf is equal to the force of friction (mf g =
Ff ), the system will be in equilibrium.
ΣF = 0 N

a = 0 m/s

2

In equilibrium, the cart set in motion continues moving with constant velocity. A new mass mf must be
found each time the cart’s mass is adjusted in Part 1,
as Ff will have changed.

Note that since the cart and mB are connected, their
acceleration, velocity, and distance traveled are equal
at all times. Thus, the horizontal distance the cart
travels, ∆x, is equal to the vertical drop of the attached mass, ∆y.

1
x = x0 + v0x t + ax t2
2

(5.5)

We now define calculated and measured accelerations
as aT heo. and aM eas. :
aT heo. is determined by Eq. 5.3;
aM eas. is determined by Eq. 5.5.
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Name:

1. State Newton’s First and Second Laws (qualitative explanations). (20 pts)

2. How is tension applied to the cart in this experiment? (15 pts)

3. How is friction compensated for in this experiment? (15 pts)

4. Should the acceleration determined in Step 5 (or any part of this experiment) be greater than, less than, or equal
to the acceleration of gravity? Explain. Assume friction is negligible; refer to Eq. 5.3. (20 pts)

5. Complete the free-body diagrams for the two situations shown below. Draw to scale (i.e., your diagrams should
~ = m~a = 0.0 N and ΣF
~ = m~a > 0.0 N). (Refer to the lab manual Theory) (30 pts)
delineate between ΣF

~ = m~a = 0.0 N
Situation 1: ΣF

~ = m~a > 0.0 N
Situation 2: ΣF

Experiment 5: Newton’s Second Law
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PROCEDURE

PART 3: Graphing

PART 1: Vary the Mass of the Cart, ma

The entire cart/hanging mass system follows the
same law, ΣF = ma. This means that plotting
force vs. acceleration yields a linear relationship (of
the form y = mx).

Trial #1
1. Measure the mass of the cart, mA , using the triple
beam balance. Record it in the table provided.
2. Measure the frictional force acting on the cart:
Add small masses to the string until the cart maintains a constant velocity when tapped. The weight
of mf is equal to Ff . Record mf in the table provided.

16. Open Graphical Analysis.
Graph force
(mB g) vs. acceleration (aM eas. ) for the Varying
Force trials. Apply a linear fit to the three data
points. Print this graph.
17. Create a similar graph of mB g vs. aT heo. and print
it.

3. Attach mB (0.05 kg) to the end of the string. [Measure its actual mass and record it]
4. Use a stopwatch to measure the time it takes
for the cart to travel a distance ∆x (or for mB
to fall the same distance ∆y). Your data will
be more accurate if ∆x is as large as possible.
Do not allow the cart to hit the pulley.
5. Determine theoretical and measured acceleration
for the cart.
Trial #2
6. Remove mB from the system. Add 0.5 kg to the
cart and measure its total mass.
7. Determine the new force of friction on the cart and
adjust mf .
8. Replace mB and measure time and distance of the
cart’s motion.
9. Determine acceleration for this heavier cart.
Trial #3
10. Remove mB and add 0.5 kg to the cart. Measure
the force of friction and adjust mf for this case.
11. Replace mB and determine acceleration for this
case.

PART 2: Vary the Applied Force
12. Keep the weight of the cart (approx. 1.5 kg) and
keep the same mf as in the previous step.
13. Trial #1:
Increase mB to 0.07 kg, find aT heo. and aM eas.
14. Trial #2:
Increase mB to 0.09 kg, find aT heo. and aM eas.
15. Trial #3:
Increase mB to 0.11 kg, find aT heo. and aM eas.

QUESTIONS
Reminder: Use the method specified on Page 5 for
Question 2
1. Assume a modified Atwood’s Machine arrangement
similar to today’s experiment and a frictionless cart
that continues moving after the hanging mass has
reached the floor, thus no longer exerting a force
on the cart. Qualitatively sketch v vs. t for this
arrangement, starting from rest at t = 0.0 s, and
include times after the hanging mass has reached
the floor (long table!).
2. Draw a free-body diagram for the cart/hanging
mass system shown in Fig. 5.2, ignoring friction.
Use this diagram to derive an equation of force, T ,
that has only masses and acceleration due to gravity, g (i.e., an equation similar to Eq. 5.4).
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Experiment 6: Coefficients of Friction

Figure 6.1: Inclined Plane
EQUIPMENT
Inclined Plane
Wood Block
Triple-Beam Balance
Digital Balance
Lab Pro and Connections
Dual-Range Force Sensor
Masses
Mass Hanger
10 cm length of string
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Advance Reading
Text: Newton’s Laws, maximum static friction, kinetic
friction, coefficients of friction.
Lab Manual: Appendix C (Logger Pro)
Objective
To measure and analyze the coefficients of friction µs
and µk between a wood block and wood plane.
Theory
Friction is the force that resists the relative motion of
one surface in contact with another surface. We consider two types of friction: static and kinetic. Usually,
kinetic friction is less than the maximum value of static
friction.

When a = 0.0 m/s2 , the force probe measures the force
necessary to counteract friction and thus is equal to Ff .
If the block is pulled at constant velocity, starting from
rest, there is a “bump” at the beginning of the graph,
and the remaining graph is, on average, horizontal.
The bump at the beginning of the graph is a result of
overcoming the maximum static friction, Ffmax , which
is usually greater than kinetic friction, Ffk . The maximum value of this bump allows us to determine µs .
The horizontal portion of the graph, Ffavg , allows us
to determine µk . A sketch of how your graph should
look is shown in Fig. 14. Note that the force begins at
zero newtons, which will require you to leave slack in
the string until data is being collected.

The maximum static friction is given by:
Ffmax = µs FN

(6.1)

and the kinetic friction is given by:
F fk = µ k F N

(6.2)

where µs is the coefficient of static friction, µk is the
coefficient of kinetic friction, and FN is the normal
force.
The angle of repose is defined as the maximum angle
at which an object on an inclined plane will retain its
position without tending to slide. It can be shown that
the tangent of this angle equals µs :
tan θ = µs

(6.3)

Similarly, it can also be shown that when an object
slides down an incline at constant velocity:
tan θ = µk

(6.4)

In this experiment, the frictional force between a
wooden block and the wooden surface of a horizontal
and inclined plane will be derived and measured. By
graphing these data, coefficients of static and kinetic
friction will be obtained.
As you perform this experiment, theoretical quantities will be determined prior to measuring for Part 2
through Part 5. These calculations will require the
free-body diagram solution method (refer to Page 5).

Figure 6.2: Sample Force vs. Time graph
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Name:
1. Define the angle of repose. (20 pts)

2. Using the free-body diagram solution method (Page 5), derive the equation for T for a block of mass m being
pulled horizontally (θ = 0◦ ) at a constant velocity. (Draw the forces to scale and include friction.) Note: It is
unlikely that you will be able to finish the experiment if you are not able to solve force problems in a timely
manner; refer to Prelab Questions 2, 3, and 4. (30 pts)

3. Using the free-body diagram solution method, derive the equation for T for a block of mass m being pulled up
an incline (θ > 0◦ ) at a constant velocity (tension parallel to the plane). Set the coordinate system such that the
x-axis is parallel to the incline. (Draw the forces to scale and include friction.) (30 pts)

4. Using the free-body diagram solution method, calculate T for a block of mass m = 150 g being pulled up a 15◦
incline at constant velocity. The coefficient of kinetic friction, µk , is 0.3. (20 pts)

Experiment 6: Coefficients of Friction
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PROCEDURE
PART 1: Preparation

13. A few trials using small and large diameter masses
prior to collecting data will yield more accurate results.

1. For all calculations involving forces, always use
the free-body diagram solution method provided on
Page 5.

14. You will need to determine for each trial fmax , fk ,
and FN (details follow):

2. Consider a wood block being pulled horizontally at
a constant velocity. Derive the equation of force, T ,
in terms of the following quantities: m, g, µ, θ.

• To determine the graph value of fmax , use the
Examine button, then position the cursor at
the highest peak.

3. Ask your TA to check your equation before proceeding.

• To determine fk , click-and-drag the mouse to
select the constant force section of the graph,
then use the Stats button.

4. Refer to Appendix C for Logger Pro information.
Open “12a Static Kinetic Frict.cmbl.” A window
will open as a F vs. t graph.

• To determine FN , refer to your free-body diagram solutions.

5. Calibrate the force sensor: Experiment ⇒ Calibrate
⇒ Lab Pro. The window has four tabs at the top.
Choose Calibrate. Click on “Calibrate Now.”

15. Measure all masses!
16. Define g = (9.80 ± 0.01) m/s2
17. Measure the mass m = (block + 0.5 kg).

Reading 1:
6. Calculate and enter the force due to 0.00 kg. Hold
the sensor steady, supported vertically against the
table edge. Select Keep.
Reading 2:

18. Attach the string from the block to the force sensor.
Click Collect. Pull m (block + 0.5 kg) across the
plane at a constant velocity.
19. Determine fmax , fk , and FN .
20. Increase m for each trial, in increments of 0.5 kg,
until a total of 2.5 kg has been added.

7. Measure, then suspend 0.55 kg from the sensor.
8. Calculate and enter the force due to 0.55 kg. Hold
the sensor steady. Select Keep, then OK.

PART 3: Block on an Inclined Plane: θ = 30◦

9. Test the calibration: Click Collect while suspending 0.55 kg from the force probe. The graph should
plot the correct amount of force. If it does not, then
there is a problem. First, re-calibrate. If that isn’t
sufficient, refer to Appendix C.

21. Derive T (algebraically) for an object of mass m
being pulled up an inclined (angle θ) at constant
velocity (quantities as before).
22. Use the force probe to measure T for this situation
(θ = 30◦ , m = (block + 0.5) kg)

PART 2: Block on a Horizontal Plane: θ = 0◦
PART 4: Coefficient of Static Friction
10. You will need to understand Step 11 through
Step 14 before collecting data.
11. Always leave slack in the string until the collection
of data begins.
12. Technique will be important for this experiment.
You will want to use the same part of the inclined
plane for all parts of the experiment; keep the string
parallel to the surface of the inclined plane while
pulling the block, and pull the block at a constant
velocity.

23. Measure the angle of repose by slowly raising the
inclined plane until the (block + 0.5 kg) just begins
to slide.
24. Calculate µs from the measured angle (Eq. 6.3).

PART 5: Coefficient of Kinetic Friction
25. Measure the angle that the (block + 0.5 kg), when
tapped, slides without acceleration.

Experiment 6: Coefficients of Friction
26. It can be shown that when an object slides without
acceleration after being tapped, then tan θ = µk .
Calculate µk from the measured angle.

PART 6: Graphing
27. Plot fmax vs. FN and fk vs. FN on the same graph.
28. What do the slopes represent?

PART 7: Analysis
29. Derive the angle of repose equation for an object of
mass m (Eq. 6.3).
30. It can be shown that when an object is lightly
tapped, then slides without acceleration, µk = tan θ.
Derive this equation.
31. Calculate T from Part 3 using your graph value of
µk .
32. Compare µs values obtained from Part 4 and Part 6.
33. Compare µk values obtained from Part 5 and
Part 6.

37
QUESTIONS
1. Show that µs = tan θ for the angle of repose. Refer
to Page 5.
2. If the mass of the block is tripled, does the angle of
repose change?
3. Why was it necessary to tap the block to get it
started in Part 5?
4. Why can anti-lock brakes stop a car in a shorter
distance than regular brakes? (Comment on the
difference between static and kinetic friction.)
5. Compare the graph and experimental values for the
coefficients of friction. Is µs > µk for each method?
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Experiment 7: Conservation of Energy
and Linear Momentum

Figure 7.1: Ballistic Pendulum and Equipment
EQUIPMENT
Ballistic Pendulum
30 cm Ruler
Digital Balance
Triple-Beam Balance
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Advance Reading

Text: Conservation of Energy, Conservation of Linear Momentum, Mechanical Energy, Kinetic Energy,
Gravitational Potential Energy, Elastic Potential Energy, Elastic and Inelastic Collisions.
Objective
To determine the velocity of a ball as it leaves the ballistic pendulum using conservation of linear momentum and conservation of energy considerations; to perform error analysis.

the collision (i.e., stuck together). The objects thus
move, after collision, with the same velocity. These
collisions, like inelastic collisions, conserve linear momentum but not mechanical energy.
This experiment investigates completely inelastic collisions to determine the initial velocity of the ball. When
the ballistic pendulum is fired, the ball is caught and
held by the catcher; the two objects, ball and catcher,
move together as one object after collision. We assume
that the linear momentum of the system before and after the collision is conserved, and that no energy is lost
during the ball’s flight.

Theory

First Process:

Energy is always conserved. There are different forms
of energy, and one form of energy may be transformed
into another form of energy. Mechanical energy, a
form of energy being investigated today, is not always
conserved.

Conservation of linear momentum between state 1 and
state 2 (just before and just after a collision) is:

The mechanical energies being investigated today are
kinetic energy, KE, and gravitational potential energy,
P Egrav :
1
(7.1)
KE = mv 2
2
where a mass, m, has energy due to its speed, v, and
P Egrav = mgh

(7.2)

where a mass m has energy as a result of its position
(height, h), and g is acceleration due to gravity.
Linear momentum, ~p , is always conserved in an isolated system. An isolated system is a system in which
all forces acting on the system are considered.
Linear momentum p is given by:
~p = m~v

(7.3)

where a mass, m, has a velocity, v. There are three
distinct categories of collisions: elastic, inelastic, and
completely inelastic.
Elastic collisions result in conservation of both linear
momentum and mechanical energy. Billiard balls are
often used as examples when discussing elastic collisions.
Inelastic collisions result in deformation of one or more
of the objects involved in the collision. Although linear momentum is conserved, mechanical energy is not.
Car wrecks are examples of inelastic collisions.
Completely inelastic collisions refer to collisions that
result in objects becoming attached to each other after

~2
~p1 = m~v1 = ~p2 = mV

(7.4)

Relevant to this experiment, we consider a collision
between a ball of mass m and a catcher of mass M .
Before the collision, state 1, the velocity of the catcher
is 0.0 m/s. Just after the collision, state 2, the velocity
of the ball and the catcher are equal.
~2
~p1 = m~v1 = ~p2 = (m + M )V

(7.5)

Second Process:
While mechanical energy is not conserved during an inelastic collision. However, after the collision, the ballcatcher system has KE due to its motion. We assume
that mechanical energy is conserved (i.e., ignore rotational energy and energy losses due to friction). KE is
transformed into P Egrav as the pendulum arm swings
up to a height h.
The initial mechanical energy is all KE, as the pendulum arm is at the lowest possible position. The final energy is all P Egrav when the pendulum rises and
stops, state 3. Therefore, conservation of mechanical
energy is:
KE =

1
(m + M )V22 = P Egrav = (m + M )gh (7.6)
2

When a pendulum rotates θ◦ , the center of mass, cm,
rises an amount h = hf − hi . Refer to Fig. 7.2.
By measuring the change in height, h, of the center of
mass of the pendulum arm, P Egrav can be determined.
A mark is scribed on the pendulum arm, just above
the catcher. Once h is determined, one can calculate
V2 using Eq. 7.6, which, in turn, allows calculation of
v1 . Note the use of capital V for V2 ; this is to distinguish it from the notation used for the initial velocity
of the ball when fired from detent 2, v2 .

Experiment 7: Conservation of Energy and Linear Momentum

Figure 7.2: The change in height of the center of mass
is h ≡ hf − hi
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Name:

1. State the Law of Conservation of Linear Momentum. (10 pts)

2. State the Principle of Conservation of Mechanical Energy. (10 pts)

3. Solve the following equations (2 equations with 2 unknowns) for x in terms of: m, g, h. Refer to Appendix A: Math
Review if necessary. (10 pts)
6x = 9y
5y 2 = mgh

4. Solve the following equations (2 equations with 2 unknowns) for x in terms of: m, M , g, h. (20 pts)
mx = (m + M )y
1
2 (m

+ M )y 2 = (m + M )gh

(continued on next page)
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5. Solve Eq. 7.5 and Eq. 7.6 (2 equations with 2 unknowns) for v1 in terms of: m, M , g, h. (20 pts)
mv1 = (m + M )V2
1
2 (m

(Eq. 7.5)

+ M )V22 = (m + M )gh

(Eq. 7.6)

6. You shoot a ball, m = 50.0 g, into a catcher, M = 200.0 g; the center of mass rises 15.0 cm. Calculate v1 . Refer
to your answer for Question 5. (20 pts)

7. You will fire the spring gun 3 times from the first detent and measure the change in height of the (pendulum +
ball) for each shot. Write the equation for the change in height of the first shot. (10 pts)
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PROCEDURE
1. Measure the mass of the ball (m) and catcher arm
(M ). [Unscrew the knurled nut to remove the arm;
screw it back when finished.]
2. Measure the radius to the center of mass of the
ball/pendulum system. The center of mass is the
top of the opening of the ball catcher.
3. Fire the ball into the catcher and measure the
change in height of the ball/pendulum system.
∆h = r − r cos Θ
4. Record ∆h for 3 trials at the first detent (short
range). Calculate the average ∆h for this detent.
Record it in the table provided.
5. Conservation of energy dictates that the total energy remains constant throughout the motion of the
pendulum [the force of friction is ignored]. Use this
knowledge of energy conservation to determine the
velocity of the ball + pendulum just after collision.
6. Write an equation relating the value of the conserved quantity (or quantities) before and after the
collision. Calculate the initial velocity of the ball
before collision, ~vi .
7. Repeat Step 3 through Step 4 for detent 2 (medium
range) to determine ~v2 .
8. Repeat Step 3 through Step 4 for detent 3 (long
range) to determine ~v3 .

Figure 7.3: The cm of the pendulum + ball is just
above the cylinder of the pendulum.

QUESTIONS
1. For each detent, calculate the momentum of the ball
just after it is fired. (Assume an isolated system.)
2. Assume that the ballistic pendulum was not held
firmly to the table when it was fired. What effect
would this have on v1 ?
3. Write the algebraic equation for mechanical energy
just before the collision between the ball and the
pendulum arm.
4. Write the algebraic equation for mechanical energy
just after the collision between the ball and the pendulum arm.
5. For each detent:
• Calculate the mechanical energy of the system
just before the collision.
• Calculate the mechanical energy of the system
just after the collision.
• What percent of the initial mechanical energy
remains after the collision?
6. What happened to the “lost” mechanical energy?

Experiment 8: Torques and Rotational
Motion

Figure 8.1: The wood block provides necessary height for the hangers to not touch the table.

EQUIPMENT
Fulcrum
Meter Stick
Vernier Caliper
(3) Mass Hangers
Masses
(3) Hanger Clamps (Clamps)
(1) Knife-Edge Clamp
Digital Balance
Triple-Beam Balance
Block of Wood
Unknown Mass (Marble or “Silver” Cube)
TA’s Table:
(1) Dial-O-Gram Balance

Figure 8.2: Clamp - The arrow indicates the correct
edge for position measurement.
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Advance Reading

Text: Torque, center of mass, stable and unstable equilibrium, lever arm
Lab Manual: Appendix B
Objective
To measure torques on a rigid body, to determine the
conditions necessary for equilibrium to occur, to perform error analysis.
Theory

The system under consideration for this experiment
will need to not only attain equilibrium, but also remain in equilibrium. This will require that the object
be in stable equilibrium, meaning if a slight displacement of the system occurs, the system will return to
its original position (e.g., a pendulum). If the system
were to move farther from its original position when
given a slight displacement, it would be in unstable
equilibrium (e.g., a ball on a hill).
Once stable equilibrium has been attained for each experimental arrangement, measure the mass at each position using the appropriate balance.

When a force F is applied to a rigid body at any point
away from the center of mass, a torque is produced.
Torque, τ (Greek letter, tau), can be defined as the
tendency to cause rotation. The magnitude of the vector is:
τ = rF sin θ

(8.1)

where r is the distance from the point of rotation to
the point at which the force is being applied (i.e., lever
arm), and F sin θ is the component of the force perpendicular to r. Note that the unit for torque is mN
(meter × newton).
In this experiment, all forces will be acting normal
(perpendicular) to the meter stick: θ = 90◦ ; therefore,
sin θ = 1. The equation for torque is simplified:
τ = rF

(8.2)

Equilibrium, Latin for equal forces or balance, is
reached when the net force and net torque on an object
are zero. The first condition is that the vector sum of
the forces must equal zero:
~ = ΣFx = ΣFy = ΣFz = 0.0 N
ΣF

(8.3)

The second condition that must be met is that the net
torques about any axis of rotation must equal zero. We
will use the standard convention for summing torques.
Torques that tend to cause counterclockwise rotation,
τcc , will be positive torques, while torques that tend to
cause clockwise rotation, τc , will be negative torques.
Σ~τ = Σ~τcc − Σ~τc = 0.0 mN

(8.4)

Figure 8.3: Required sketch for each experimental arrangement

Once stable equilibrium is attained, sketch each set-up:
x:
F:
Arrow :
r:
cc:
c:
cm:
f:

position
magnitude of force
direction of force
lever arm
counterclockwise
clockwise
center of mass
fulcrum

Prelab 8: Torques and Rotational Motion
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Name:

1. Define torque, and state the conditions necessary for stable equilibrium. (20 pts)

2. Why are the following equations equivalent for this experiment? (20 pts)

τ = rF sin θ

τ = rF

3. Refer to the procedure, Part 1, 1st arrangement. Assume xcm = 50.0 cm, 150.0 g is suspended from a hanger
clamp at the position xcc = 15.0 cm, and a hanger clamp is at position xc = 75.0 cm. If each hanger clamp has a
mass m = 16.5 g, what mass must be added to xc in order to attain stable equilibrium? Sketch a diagram of the
situation (refer to Fig. 8.3). (30 pts)

4. Consider Part 2 of the procedure. Determine the additional mass required for stable equilibrium. Meter stick:
xcm = 50.0 cm, m = 150.0 g. Hanger clamp: xcc = 0.0 cm, m = 16.5 g. (30 pts)

Experiment 8: Torques and Rotational Motion
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PROCEDURE

QUESTIONS

PART 1: Quantitative Analysis of Torque

1. Consider the Dial-O-Gram balance and the triplebeam balance. The Dial-O-Gram balance has a
spring, calibrated for Earth, behind the dial. This
spring exerts a force that allows accurate measurement of mass. The triple-beam balance uses only
the principles of torque, which you investigated in
this experiment. Will either balance allow us to
accurately measure the mass of an object on the
moon?

1. Place the knife-edge clamp at the 50 cm position of
the meter stick with the screw pointing down. Adjust the knife-edge clamp until the meter stick is balanced and horizontal (stable equilibrium). Record
this position as xcm .
2. Place a clamp at the xcc = 15 cm position and hang
200 g from it.
3. Place another clamp at the xc = 75.0 cm position.
Add enough mass to attain equilibrium. If small
fractional masses are not available to you, it may
be necessary to adjust the position of the 75 cm
clamp in order to balance the system.
4. Measure the mass at each position; recall that the
digital balance has a limit of 0.2 kg.
5. Determine the force, radius, and torque at each position.
6. Calculate the sum of the torques.

PART 2: One-Person See-Saw
7. Remove all clamps from the meter stick. Measure
and record the mass of the meter stick.
8. Place the fulcrum at 20 cm on the meter stick.
9. Place a clamp as close to the zero end as possible. Add mass incrementally to attain static equilibrium. Measure this mass.
10. Make a torque-balance sketch similar to the one in
Step 6; fill it in with the appropriate values. Calculate the net torque about the fulcrum. Note that
the meter stick behaves as though all of its mass is
concentrated at its center of mass.

PART 3: Unknown Mass
11. Determine the mass of a metal cube experimentally,
using the torque apparatus however you choose.
12. Make a torque-balance sketch of your experimental
setup.
13. Determine the density of the metal cube by measuring its dimensions.
14. Identify the metal using the density chart provided
in Table 1.1 (Page 9). Compare your value of density to the accepted ρ value for that material.

2. Calculate δΣτ for each Στ you determined in Part 1,
Part 2, and Part 3. Is each Στ within experimental
uncertainty?

Experiment 9: Moments of Inertia

Figure 9.1: Beck’s Inertia Thing with masses
EQUIPMENT
Beck’s Inertia Thing
Vernier Caliper
30cm Ruler
Paper Clips
Mass Hanger
50g Mass
Meter Stick
Stopwatch
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Advance Reading

so the tension is

Text: Torque, Rotational Motion, Moment of Inertia.
Objective
To determine the moment of inertia of a rotating system, alter the system, and accurately predict the new
moment of inertia .
Theory
Moment of Inertia (I) can be understood as the rotational analog of mass. Torque (τ ) and angular acceleration (α) are the rotational analogs of force and
acceleration, respectively. Thus, in rotational motion,
Newton’s Second Law:
F = ma

(9.1)

τ = Iα.

(9.2)

becomes:

An object experiencing constant angular acceleration
must be under the influence of a constant torque
(much like constant linear acceleration implies constant force). By applying a known torque to a rigid
body, measuring the angular acceleration, and using
the relationship τ = Iα, the moment of inertia can be
determined.
In this experiment, a torque is applied to the rotational apparatus by a string which is wrapped around
the axle of the apparatus. The tension T is supplied
by a hanging mass and found using Newton’s second
law.

Figure 9.2: String wrapped around axle.
If we take the downward direction as positive, and apply Newton’s second law, we have:
ΣF = mg − T = ma

(9.3)

T = m(g − a)

(9.4)

The rotational apparatus has an original moment of inertia I0 with no additional masses added. When
additional masses are added, it has a new moment of
inertia Inew . The added masses effectively behave as
point masses. The Moment of Inertia for a point mass
is Ip = M R2 , where M is the mass and R is the radius
from the point about which the mass rotates. Thus,
the relationship between I0 and Inew is given by
Inew = I0 + Ip1 + Ip2 + ... = I0 + M1 R12 + M2 R22 + ...
(9.5)
where M is an added mass and R is the distance of
this mass from the center of the wheel (i.e. from the
axis of rotation). So, if multiple masses are added at
the same radius, we have
Inew = I0 + ΣIp = I0 + (ΣM )R2

(9.6)

In comparing this to Eq. 9.1, we consider that all
masses, along with the disk, experience the same angular acceleration. If we were looking for the Force
on a system of connected masses all experiencing the
same acceleration, we would simply sum the masses
and multiply by acceleration (i.e. a stack of boxes being pushed from the bottom). Similarly, when looking
for the Torque on a system, we must sum the moments
of inertia and multiply by angular acceleration.
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PROCEDURE
PART 1: Moment of Inertia of apparatus with
no additional masses.
1. Using the vernier caliper, measure the diameter of
the axle around which the string wraps. Calculate
the radius of the axle.
2. Wrap the string around the axle and attach enough
mass to the string to cause the apparatus to rotate
very slowly. The angular acceleration of the disk
should be nearly zero. Record this mass and use it
to calculate the frictional torque.
3. Holding the disk, place an additional 50 grams
(mass hangers are 50 grams) on the string. Measure
the distance from the bottom of the mass hanger to
the floor.

Experiment 9: Moments of Inertia
PART 2: Moment of Inertia of apparatus
with additional masses.
12. Measure the distance from the center of the disk to
the outer set of tapped holes (Where you will attach
the three large masses).
13. Attach the three masses to the disk. Using the mass
stamped on the top/side of the masses, calculate the
new moment of inertia, Inew , for the system.
14. Repeat Step 1 through Step 10 for the altered system. Calculate the percent difference between the
experimental value and the calculated value.
Questions
1. What are the units for Torque, Moment of Inertia, and Angular Acceleration? Show all work.

4. Release the disk, be sure not to impart an initial
angular velocity. Using the stopwatch, measure the
time until the mass hanger reaches the floor.

2. If the Torque applied to a rigid body is doubled,
what happens to the Moment of Inertia?

5. Repeat Step 3 five times. Record the times in a
table and calculate the average time.

3. Compare friction compensation in this experiment
to friction compensation in Newton’s Second Law.

6. Using the average time, calculate the linear acceleration of the masses.
7. Calculate the angular acceleration of the disk using
α = ar . Refer to Step 1 for r.
8. Calculate the tension on the string, Eq. 9.4. Be sure
to use the total hanging mass.
9. The applied torque on the spinning disk is provided
by the tension of the string. Use the values from
Step 1 and Step 7 to calculate the net torque,
which is applied torque minus friction torque.
10. Repeat Step 2 through Step 8 for 100 grams on the
mass hanger in addition to the mass from Step 1.
11. Using Graphical Analysis, plot the net torque vs.
angular acceleration. Be sure to enter the origin as a data point. Determine the moment of
inertia I0 .

Experiment 10: Archimedes’ Principle

Figure 10.1
EQUIPMENT
Triple-Beam Balance with string
Graduated Cylinder
Pipette
Cylinders: (2) Metal, (1) Wood
(Note: The cylinders have sharp hooks)
Overflow Container
Spouted Can
Digital Balance
(2) 123-Blocks
Wood Board/Block
Rod & Clamp
Paper Towels
Water
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Advance Reading
Text: Archimedes’ principle, buoyant force, density
Objective
The objective of this lab is to investigate the buoyant
force acting on a variety of objects, the density of the
objects, and the density of our tap water.
Theory
Archimedes’ principle states that a body wholly or partially submerged in a fluid is buoyed up by a force equal
in magnitude to the weight of the fluid displaced by the
body.
It is the buoyant force that keeps ships afloat (object partially submerged in liquid) and hot air balloons
aloft (object wholly submerged in gas). We will investigate the buoyant force using the following methods:
• Direct Measurement of Mass
• Displacement Method
When an object is submerged in water, its weight
decreases by an amount equal to the buoyant force.
The direct measurement of mass will measure the
weight of an object first in air, then while it is submerged in water. The buoyant force, FB , is equal
to the weight in air (Fg ) minus the weight in water,
Fg′ = m′ g:
FB = Fg − Fg′

(10.1)

The displacement method requires measurement of
the volume of fluid displaced by the object. The weight
of the fluid displaced is equal to the buoyant force exerted on the object. Thus, the buoyant force is given
by:
FB = ρgV

(10.2)

where ρ (Greek letter, rho) is the density of the fluid
displaced, V is the volume of fluid displaced by the
object, and g is the acceleration due to gravity.

The following exercises will be informative, as both
floating and sinking objects are used in this experiment.
• Sketch a free-body diagram for an object that
is floating in water. How much water does it
displace? Does it displace its volume in water?
Does it displace its weight in water?
• Sketch a free-body diagram for an object that
is submerged in water. How much water does it
displace? Does it displace its volume in water?
Does it displace its weight in water?
The accepted value for the density of pure water at 4◦ C
and 1 atm is ρwater = (1000 ± 1) kg/m3 . We will use
this value for the density of water for Part 2 through
Part 5. That is, we assume a temperature in the lab
of 4◦ C!
We will then experimentally determine the density of
the tap water we used (Part 6) and compare it to the
density of water at 20◦ C. The density of pure water at
20◦ C is:
ρwater = (998.21 ± 0.01) kg/m

3

(10.3)

When comparing the experimental densities of your
objects or tap water, please use Table 1.1 provided at
the end of Experiment 1: Measurement & Analysis on
Page 9.

Prelab 10: Archimedes’ Principle
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Name:
1. State Archimedes’ principle. (20 pts)

2. Explain the relationship FB = ρV g. (25 pts)

3. Briefly explain the methods used in Part 1 through Part 3 of this experiment to determine buoyant force. (25 pts)

4. Draw a free-body diagram for an object of mass M , for the following two situations:
a. a submerged object suspended by a string; b. a floating object. Draw to scale. (30 pts)

Experiment 10: Archimedes’ Principle
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PART 4: Aluminum Cylinder

PROCEDURE
PART 1: Overflow Method
1. Measure the mass of the brass cylinder. Determine
its weight, Fg .
2. Place the overflow container on the digital balance.
3. Fill the spouted can with water. Position it so that
its spigot pours into the overflow container.
4. Submerge the brass cylinder in the water, allowing
displaced water to collect in the overflow container.
5. Measure the mass of the displaced water; calculate
its weight. This is the buoyant force, FB .
6. Calculate ρobj (density of the object):
ρobj

ρW F g
=
FB

(10.4)

17. Repeat Part 1 through Part 3 for the next object
(aluminum cylinder).
18. Draw a free-body diagram for this object submerged
in water.
PART 5: Buoyant Force - Floating Object
19. Although you need to modify or omit certain steps,
repeat Part 1 through Part 3 for the wood cylinder:
• Omit Step 6, Step 11, and Step 16.

• Modify Step 9 and Step 13: Allow the wood
object to float.

20. Draw a free-body-diagram for the wood object floating in water.
PART 6: Density of Tap Water

PART 2: Direct Measurement - Mass
7. Calibrate the triple beam balance.
8. Suspend the object (brass cylinder) from a string
attached to the balance.
9. Partially fill the overflow container with water, then
submerge the object. Do not allow the object to
touch the container. Measure the apparent mass of
the object in water, m′ . Calculate Fg′ .
10. Determine FB for the object. How much less does
it weigh in water than in air? (Eq. 10.1)
11. Calculate ρobj using Eq. 10.4.

m − m′
= ρW
V

(10.6)

QUESTIONS
1. Consider situations A and B, below. Does one tub
weigh more than the other, or do they weigh the
same? Draw a free body diagram for each case.
A. A tub filled to the brim with water.
B. A tub filled to the brim with water, with a
boat floating in it.

PART 3: Displacement Method - Volume
12. Partially fill the graduated cylinder with water; take
note of the water level. Use the pipette to fine-tune
the meniscus.
13. Carefully submerge the object in water and determine its volume.
14. Remove and dry the object, then empty the graduated cylinder and invert it on a paper towel to dry.
15. Determine FB on the object with Eq. 10.2.
16. Calculate ρobj using Eq. 10.5:
m
ρobj =
V

21. For each metal object: Use Eq. 10.6 and the graduated cylinder volume from Part 3 to determine the
density of our tap water.

(10.5)

Use the volume determined from the displacement
method and m, not m′ .

2. A 827 cm3 gold nugget and a 827 cm3 aluminum
block are immersed in water. Which object experiences the greater buoyant force?
3. A ship made of steel (ρsteel = 7.8 × 103 kg/m3 ) will
float in water. Explain, in terms of densities, how
this is possible.
4. Verify that Eq. 10.4 is true for an object submerged
in water. (Start by writing the equations for each
force.)
5. Consider a pirate boat in a pond with the anchor
on the boat. When the pirates throw the anchor
overboard, what happens to the water level at the
shore? Does the water at the shore rise, fall, or stay
at the same level? Explain, in terms of Archimedes’
principle (density, volume, or weight), why this happens.

Experiment 11: Simple Harmonic Motion

Figure 11.1
EQUIPMENT
Spring
Metal Ball
Wood Ball
(Note: sharp hooks)
Meter Stick
Digital Balance
Stopwatch
Pendulum Clamp and Rod
String
Masses: (2) 100g, (1) 50g
Mass Hanger
Table Clamp
Protractor
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Advance Reading
Text: Simple harmonic motion, oscillations, wavelength, frequency, period, Hooke’s Law.
Lab Manual: Appendix C
Objective
To investigate simple harmonic motion using a simple
pendulum and an oscillating spring; to determine the
spring constant of a spring.

The period of oscillation of an ideal, simple pendulum
depends on the length, L, of the pendulum and the
acceleration due to gravity, g:
s
L
T = 2π
(11.3)
g
When setting the pendulum in motion, small displacements are required to ensure simple harmonic motion.
Large displacements exhibit more complex, sometimes
chaotic, motion. Simple harmonic motion governs
where the small angle approximation is valid:

Theory
Periodic motion is “motion of an object that regularly
returns to a given position after a fixed time interval.” Simple harmonic motion is a special kind of periodic motion in which the object oscillates sinusoidally,
smoothly. Simple harmonic motion arises whenever
an object is returned to the equilibrium position by a
restorative force proportional to the object’s displacement.
F = −kx

(11.1)

The illustrative example above is Hooke’s Law, which
describes the restorative force of an oscillating spring
of stiffness k (spring constant).
For an ideal, massless spring that obeys Hooke’s
Law, the time required to complete an oscillation (period, T , seconds) depends on the spring constant and
the mass, m, of an object suspended at one end:
r
m
(11.2)
T = 2π
k
The inverse of period is the frequency of oscillation.
Recall that frequency, f , is the number of oscillations
completed by a system every second. The standard
unit for frequency is hertz, Hz (inverse second, s-1 ).

Figure 11.2: Small Angle Approximation
The arc length, s, of a circle of radius r is:
s = rφ

(11.4)

When φ is small, the arc length is approximately equal
to a straight line segment that joins the two points.
Therefore, the following approximations are valid:
φ ≈ sin φ ≈ tan φ

(11.5)
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Name:
1. Define simple harmonic motion. What conditions must be met? (20 pts)

2. What physical phenomenon does the relationship T = 2π

pm
k

describe? (20 pts)

3. What physical phenomenon does the relationship T = 2π

q

L
g

describe? (20 pts)

4. The following data were collected for Part 1 of the lab procedure. Complete the table. The force is due to the
gravitational force. All distances are measured from the bottom of the hanger to the top of the stool. You should
ignore the initial weight of the hanger. Note that ∆x is the change from initial position, xf − x0 , not the change
from the previous position, x2 − x1 . (40 pts)

Mass (g)

Height (cm)

∆x (m)

Force (N)

0

57.5

0

0

100

46.5

200

36.5

300

25.5

400

15.5

500

4.5
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PROCEDURE

PART 3: Simple Pendulum

PART 1: Spring Constant - Hooke’s Law

10. Measure the mass of the metal ball.

1. Hang the spring from the pendulum clamp and hang
the mass hanger from the spring. Place a stool under the hanger and measure the initial height x0
above the stool.

11. Construct a simple pendulum 100.0 cm in length using the metal ball and some string. (L is measured
from the center of mass of the ball.)

2. Add 50 g to the mass hanger and determine the
change in position caused by this added weight.

12. Move the pendulum from equilibrium (about 10◦ 20◦ ) and release it. Measure the time required for
20 oscillations.

3. Add 50 g masses incrementally until 250 g has been
added to the mass hanger. Determine the total displacement and the total added weight with each addition.

13. Determine the period. Record it in the table provided.

4. Generate a graph of F vs. ∆x using Graphical Analysis. Analyze the graph with a linear fit; print a
copy for each partner.

14. Shorten L in increments of 20.0 cm and measure T
for each length.

T =

time required
20 cycles

(11.6)

15. Repeat the procedure using the wood ball.
PART 2: Spring Constant - Oscillation

16. Produce graphs of T 2 vs. L for each ball. Apply a
linear fit; print a copy for each partner.

5. Measure the mass of the spring, mass hanger, and
100 g mass.
Note: The spring used for this experiment is not ideal;
its mass affects the period of oscillation. Account for
this by adding 1/3 the mass of the spring to the value
of suspended mass, m, in your calculations.
6. Hang the spring from the pendulum clamp. Hang
the mass hanger + 100 g from the spring (refer to
Fig. 11.1).
7. Pull the mass hanger down slightly and release it
to create small oscillations. Measure the time required for 20 oscillations. (This is like measuring
one period twenty times over.)
8. Calculate the period for the oscillating spring.
9. Calculate the spring constant of the spring using
your knowledge of the object’s mass and period of
oscillation.

QUESTIONS
1. Solve Eq. 11.3 for g.
2. Does the period of a simple pendulum depend on
the mass?
3. How long must a simple pendulum be to have a
period of 1.5 s?
4. Assume you are safely located on the moon and have
access to a simple pendulum, stopwatch, and meter
stick. Is it possible to determine the acceleration
due to gravity of the moon, gmoon , using only these
three items? (Hint: gmoon 6= 0 m/s2 )
5. Consider your T 2 vs. L graph. What are the slope
values? Show that the slope should be equal to
4π 2 /g. Compare each graph value to the accepted
value.

Experiment 12: Speed of Sound in Air

Figure 12.1: Sound Tube
EQUIPMENT
Sound Tube
(3) Tuning Forks (f ≥ 300 Hz)
Mallet
Water Jug
Rubber Hose
Clamps and Rod
Paper Towels

Figure 12.2: Displacement of Air
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Advance Reading
Text: Speed of sound, longitudinal waves, wavelength,
frequency, standing wave, resonance.
Objective
The objective of this experiment is to measure the
speed of sound in air.
Theory
There are a variety of wave types.
Sound is a longitudinal wave requiring a medium in
which to propagate. A longitudinal wave is one in
which objects oscillate in the same direction the wave
propagates. The speed of sound depends on properties of the medium such as bulk modulus, density, and
temperature. The speed of sound is not a constant
value!
To calculate today’s speed of sound, v, we will determine the wavelength, λ (lambda), of the sound produced by a tuning fork of known frequency, f :
v = λf

(12.1)

A vibrating tuning fork generates a sound wave that
travels outward in all directions. When held above a
sound tube, a portion of the wave will travel down the
tube, reflect off the water’s surface, then return to the
top. If the rising pressure wave reaches the top of the
tube as the next wave is produced, the wave is reinforced, and the sound will resonate. A standing wave is
generated in the tube, and the sound will be distinctly
louder. This occurs when the column of air in the tube
has an appropriate length (height) for a given tuning
fork.

When considering the displacement of air for resonance
(constructive interference), notice that there is an antinode near the open end of the tube, and a node at the
water’s surface from which the sound is reflected (refer to Fig. 12.2). To locate multiple resonances for a
particular tuning fork, one must be able to change the
length of the air column in the tube. This will be accomplished by adjusting the water level in the tube:
raise or lower the water reservoir, and the water level
in the tube will change accordingly.
The distance between one resonance and the next is
1
2 λ. This experiment will attempt to locate at least
three resonances to reduce uncertainty of the results.
λ
= |x1 − x2 |
2

(12.2)

Having calculated λ and being given f of a tuning fork,
the speed of sound can be calculated with Eq. 12.1.

Prelab 12: Speed of Sound in Air
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Name:
1. What is a standing wave? (20 pts)

2. What is a resonant frequency? (20 pts)

3. Explain the relationship v = λf . (20 pts)

4. Refer to Eq. 12.1 and Eq. 12.3 (Step 10 of the procedure). You measure 12 λ to be 40 cm. The temperature in the
lab is 22◦ C. What is the frequency of this resonance? (40 pts)

Experiment 12: Speed of Sound in Air
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PROCEDURE

QUESTIONS

1. Raise the bottle of water until the tube is filled.
2. Hold a vibrating tuning fork above the tube and
lower the water level gradually until the sound becomes loudest (resonates). Raise the water level as
necessary.
3. Mark the water level with a rubber band.
4. Continue to lower the water level until all resonant
positions have been marked in this manner. Record
the positions in the data table provided.

1. Define ultrasonic, supersonic, and infrasonic.
2. As noted in the theory section, our sound tubes do
not have an anti-node at the open end of the tube.
Analyze your data and determine where, relative to
the open end of the tube, the anti-node is located
for each frequency used. State your answer in terms
of λ. Refer to Fig. 12.

5. Calculate the average distance “l” between resonance positions. Record it in the table provided.

3. Assume you are in a particular location (e.g., at the
beach, in the mountains, in the lab). Two sounds,
one a high frequency, one a low frequency, are generated. Does a high frequency sound travel faster
than a low frequency sound in a particular location?

6. Calculate the fundamental wavelength λ = 2l and
record it.

4. Does sound travel at the same speed in different
materials? Specify the speed of sound in 3 media.

7. Calculate the measured speed of sound ve = f λ and
record it.
8. Repeat this process for two other frequencies (3 tuning forks, total).
9. Average your three values of v. Record them in the
data table on the board.
10. Calculate a theoretical value for the speed of sound,
vT , using:
vT = (331.5 + 0.6T )m/s

(12.3)

where T is the temperature in degrees Celsius.
11. Calculate your percent error. [Eq. B.1, Page 151]

Figure 12.3: Proper position for tuning fork

1
4λ

= d1 + d2

1
4λ

= distance from position of water’s surface
when 1st resonance is heard to anti-node.
d1 : Refer to Step 2.
d2 ≡ distance from the top of the tube to the
anti-node.

Figure 12.4: Determination of anti-node location.

Experiment 13: Electrostatics

Figure 13.1

EQUIPMENT

Front Table

Ebonite Rod (Hard Rubber)
Glass Rod (or Lucite Rod)
Rabbit Fur
Plastic Film
Silk
Electroscope
Matches

Hair Dryer
Rubbing Alcohol
Paper Towels
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Advance Reading
Text: Law of conservation of electric charge, electrostatic charge, electron, proton, neutron, atomic model,
free electrons, ions, polarization, conductor, insulator,
conduction, induction, plasma.
Objective
The objective of this lab is to qualitatively study conducting and insulating materials, electric charges, and
charge transfer.
Theory
There are two kinds of charges in nature: positive
charge carried by protons and negative charge carried
by electrons. An object that has an excess of either is
said to be charged. Like charges repel each other, and
unlike charges attract.
Charge transfer is the exchange of charges between objects. In this experiment, only electrons are exchanged
while protons remain stationary. These electrons may
move around within materials or move between materials, but they can never be created or destroyed. This is
known as the law of conservation of charge. The
law of conservation of electric charge states that the
net amount of electric charge produced in any process
is zero.
A conductor is a material in which some loosely
bound electrons can move freely (free electrons) while
protons are tightly bound within the nucleus. An insulator is a material in which both electrons and protons are tightly bound. Conductors and insulators
have the following properties:

In this experiment, a glass rod or an ebonite rod (insulators) will be electrically charged by rubbing against
another insulating material. Whether the rod gains
or loses electrons will depend on the combination of
materials used (refer to the electrostatic series provided in Table 13.1 on Page 67). The charged rod will
be used to charge an electroscope (a conductor that
indicates whether it is charged) by means of conduction and by means of induction.
To charge by conduction: Bring a charged rod close
to, then touch, the electroscope. As the rod nears the
electroscope, the free electrons in the electroscope are
either attracted to or repelled by the charged rod (induction). When you touch the rod to the electroscope,
the electroscope becomes charged as electrons transfer
to (or from) the electroscope (charge transfer ).
To charge by induction: Bring a charged rod close to,
but do not touch, the electroscope. While holding the
rod near the electroscope (induction), touch the opposite side of the electroscope with the tip of your finger
(charge transfer ). Your body will act as a reservoir
of charge (ground), either giving or receiving electrons
to the electroscope. Remove your finger before moving
the rod from the proximity of the electroscope.
In Part 3, the effects of plasma on a charged electroscope will be observed. Plasma is an ionized gas
containing positive ions and free electrons. Plasma
is found in our upper atmosphere, inside fluorescent
lights, and surrounding the flame of a match.

Conductors
• Conductors are objects that allow the free flow
of electrons throughout the object.
• Charges are easily transferred between conductors.

Atom charge distribution, normal

• Charge can collect at one end of an object in the
presence of other charged objects.
Insulators
• An insulator is a material in which electrons are
tightly bound to the nucleus.
• Transferring charge between insulators requires
a force, e.g. friction, and direct contact.
• Insulators brought near other charged objects experience polarization, a shifting of electrons to
one side of an atom. (Fig. 13.2)

Atom charge distribution, polarized
Figure 13.2: Polarization
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Table 13.1: Electrostatic Series
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Name:
1. What are the objectives of this experiment? (5 pts.)

2. There are only two types of electric charge. Electrons carry a
and protons carry a

charge,

charge. (5 pts.)

3. What is conservation of charge? (20 pts.)

4. Assuming both objects are initially neutral, use the concept of conservation of charge to explain what happens
when an ebonite rod is rubbed with rabbit fur. (20 pts.)

5. Define the following: (10 pts. each)
• conductor

• insulator

• conduction

• induction

• polarize

Experiment 13: Electrostatics
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69
PART 3: Electroscope and Plasma

PART 1: Charging by Conduction
Negative by Conduction

13. Apply a charge to the electroscope by a method of
your choosing.

1. Charge a rod negatively by rubbing it with a material that will give it extra electrons.

14. Light a match and hold it near the electroscope,
observing its behavior.

2. Bring the negatively charged rod close to the electroscope bulb without touching it. Observe how the
leaves of the electroscope repel each other.

15. Sketch this process.

3. Touch the charged rod to the electroscope. Observe
the behavior or the electroscope during conduction
and as you remove the rod.
4. Draw a series of sketches showing the movement of
charges during this process.
Positive by Conduction
5. Charge the electroscope positively by conduction
using a glass rod.
6. Sketch the various stages of this process.

PART 2: Charging by Induction
Positive by Induction
7. Bring a negatively charged rod close to the electroscope, but do not touch it.
8. While the electroscope’s leaves are separated, touch
the electroscope bulb with your finger to ground it.
Remove your finger.
9. Remove the charged rod from the vicinity of the
electroscope; observe its final state.
10. Draw a series of sketches showing the movement of
charges during this process.
Negative by Induction
11. Charge the electroscope negatively by induction.
Which rod will be required?
12. Sketch the various stages of this process.

QUESTIONS
1. What is meant by conservation of charge?
2. Why do charged balloons cling to a wall, which is
also an insulator and has a neutral charge?
3. Explain the difference between an insulator and a
conductor. Give 3 examples of each.
4. Is the fur positively or negatively charged after
charging an ebonite rod?
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Experiment 14: Electric Fields and
Potentials

Figure 14.1: Electric Fields and Potentials
Power Supply: Always connect the red lead to the red post and the black lead to the black post. Turn the power
supply off and get a TA to check the circuit prior to plugging in the power supply.
Digital Multi-Meter (DMM) as a Voltmeter: Connect the red lead to the V /Ω jack and the black lead to the COM
jack. Turn the dial to 20V DCV and turn on. You will need to adjust the voltmeter scale (turn the dial) as you
perform experiment. Adjust the scale so that you obtain the most significant figures possible without incurring an
overflow symbol (”1.”).
EQUIPMENT
Conductive/Resistive Paper (2)
Electric Fields Circuit Board
(2) Point Charge Connectors
(2) Parallel Plate Connectors
(4) Posts (2 Red, 2 Black)
Tip Holder
Digital Multi-Meter (DMM)
Power Supply
Grease Pencil (or white colored pencil)
(4) Wire Leads
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Advance Reading

Text: Electric field, electric potential energy, equipotential, voltage.
Lab Manual: Appendix C - iMac
Appendix ??: Equipment - DMM
Objective
To map equipotential lines and electric field lines of
two charge arrangements; to measure the electric field
strength of each arrangement.
Theory

Figure 14.2: Point Charge Arrangement

Electric potential (voltage) at a point is defined as
the amount of potential energy per coulomb of charge
placed at that point. Potential is only defined as a difference in voltage between two points. This change in
voltage, ∆V , is equal to the negative of the work done
by the electric force to move a charge from one point
to another:
∆V = Vb − Va = −W/q

(14.1)

An equipotential surface is defined as a surface
where all points on the surface have the same electric
potential. To move a charge around on such a surface
requires no work. In two dimensions, the equipotential surfaces are equipotential lines. How close the lines
are to each other is an indication of the strength of the
corresponding electric field.

Figure 14.3: Parallel Plate Arrangement

An electric field, E, at a point is defined as the force
per coulomb exerted on a charge at the point:
~ = F/q
~
E

(14.2)

Electric fields push positive charges toward a lower
state of potential energy, or towards a lower equipotential. Thus, electric field lines are always perpendicular
to equipotential lines.
Electric field can also be measured by how quickly
voltage is changing at that point, in volts/meter. A
stronger electric field indicates electric potential is
varying more rapidly over a particular distance.
The two conductive patterns we investigate for this
experiment, point charges and parallel plates, are on
conductive/resistive paper.

Figure 14.4: Tip Holder
Note the 3 holes for positioning tips of wire leads.
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Name:
1. Define electric potential. State the units. (15 pts)

2. What is an equipotential surface? (20 pts)

3. Define electric field. State the units (both that are listed in the text). (20 pts)

4. Complete the statement: Electric field lines are always
(10 pts)

to equipotential surfaces.

5. Calculate the electric field strength of the following
arrangement. Assume the leads are 1.00 cm apart
and the electric potential difference measured with
the voltmeter is 0.673 V. Refer to the procedure.
(20 pts)

Figure 14.5: Electric Field Strength Arrangement
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PROCEDURE
Digital Multi-Meter as Voltmeter

1. Connect a black lead to the COM jack and a red
lead to the V /Ω jack.
2. Turn the dial to 20V DCV and turn on the DMM
(it is now acting as a voltmeter).

PART 1: Setup and Connections
3. Place the conductive/resistive paper on the circuit
board. Poke two holes in the paper matching the
holes in the circuit board as shown in Fig. 14.2.
4. Place a point charge connector over each hole; affix
them with one red post and one black post.
5. Connect the power supply to the point charge posts,
black-to-black (ground) and red-to-red (positive).
6. Connect the voltmeter to the point charges, on top
of the power supply leads.
7. Ask your TA to approve your circuit. Then, plug in
the power supply and set the voltage to 6.0 V.
8. Label the point charges with a grease pencil (the
ground lead is at 0.0 V, the positive lead is at 6.0 V).

PART 2: Point Charges
Equipotential Lines
9. Remove the voltmeter positive lead from the point
charge and drag it across the conductive paper.
Bring it closer to the ground lead until the voltmeter reads 1.00 V. (Adjust the voltmeter scale to
give the most significant figures without getting an
overload symbol, “1.”)
10. Mark a dot at this location with the grease pencil.
Move the voltmeter lead around the paper until you
locate eight points where the voltmeter reads 1.00 V
and mark each of them.
11. Connect the dots with the grease pencil to create an
equipotential line. Label this line with its voltage.
12. Have your partner repeat this process to locate the
2.0 V equipotential.
13. Take turns with your partner to locate the 3.0 V,
4.0 V, and 5.0 V equipotentials.

Electric Field Strength
14. Measure the electric field strength (∆V /∆x) at the
3.0 V equipotential, at the center of the paper:
(a) Measure the change in voltage between two
points placed closely together, on either side
of the 3.0 V line. Use the clear plastic tip
holder to maintain a measurable separation of
the leads (the holes are about 1 cm apart).
(b) Calculate the field strength, in V/m, at this
location. Record it in the table provided.
(c) Mark the location on the conductive paper and
label the strength of the field.

Electric Field Lines
15. Place the DMM leads in each end of the tip holder.
Place the positive lead immediately next to the
6.0 V point charge, slightly off-center of a line that
would connect the two point charges. Hold the positive lead steady and pivot the ground lead around it,
noticing the ∆V readings on the voltmeter changing.
16. Pivot the black lead until you find the maximum
reading on the voltmeter. Mark the location of the
black lead by pressing the tip into the paper to make
an indentation.
17. Move the red lead to the indentation made by the
black lead. Pivot the black lead around this location
as before, finding the direction of greatest voltage
change.
18. Continue to “walk” the leads across the paper until you reach the 0.0 V point charge. Connect the
dots with the grease pencil. The resulting line is an
electric field line.
19. Have your partner repeat this process, Step 15 Step 18, beginning from a different position on the
6.0 V point charge. Remove the point charge posts
and conductive paper. Keep the paper as data.

PART 3: Parallel Plates
20. Affix a new sheet of conductive paper to the circuit
board using four posts as shown in Fig. 14.3. Use
red posts for one parallel plate and black posts for
the other.
21. Outline the parallel plates with the grease pencil.

Experiment 14: Electric Fields and Potentials
Equipotentials
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QUESTIONS

22. Locate the 2.0 V equipotential (as in Part 2). Connect the dots and label its voltage. Extend it at
least three points past the ends of the plates.

1. Refer to Table 14.1. Show that the electric field unit
of N/C equals V/m.

23. Have your partner repeat this process for the 4.0 V
equipotential.

Current

Amp [A]

Coulomb/second

Potential Difference

Volt [V]

Joule/Coulomb

Power

Watt [W]

Joule/second

Resistance

Ohm [Ω]

Volt/Amp

Electric Field Strength
24. Measure the field strength at the center of the paper, between the plates (as in Part 2). Mark the
position and field strength on the paper.
25. How does this compare to the average electric field
between the two plates? Calculate the average electric field (∆V /∆x) between the plates, then find the
percent difference of your measured value.
Electric Field Lines
26. It is known that the electric field between two plates
is a series of parallel lines going straight from one
plate to the other. Locate and draw two of the field
lines outside of the ends of the parallel plate configuration.
27. Unplug and organize the equipment on your table. Keep the conductive paper as data. Staple
one of the charge arrangements to the back of your
datasheet; staple the other to your lab partner’s
datasheet.

Table 14.1: Electric Quantities and Units
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Experiment 15: Ohm’s Law

Figure 15.1: Simple Series Circuit
EQUIPMENT
Universal Circuit Board
Power Supply
(2) DMM’s
150 Ω Resistor (R1 )
330 Ω Resistor (R2 )
560 Ω Resistor (R3 )
Miniature Light Bulb and Socket (R4 )
(1) Jumper
(6) Wire Leads

Figure 15.2: Schematic: Simple Series Circuit
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Advance Reading
Text: Ohm’s Law, voltage, resistance, current.
Lab Manual: Appendix C, Appendix ?? - DMM
Objective
The objective of this lab is to determine the resistance
of several resistors by applying Ohm’s Law. Students
will also be introduced to the resistor color code and
refresh their graphing skills.
Theory
Ohm’s Law states that the current, I, that flows in a
circuit is directly proportional to the voltage, V , across
the circuit and inversely proportional to the resistance,
R, of the circuit:
V
(15.1)
I=
R
In this experiment, the current flowing through a resistor will be measured as the voltage across the resistor
is varied. From the graph of this data, the resistance is
determined for Ohmic resistors (Ri , i = 1, 2, 3). NonOhmic resistors (R4 , light bulb) do not obey Ohm’s
Law.
Ammeters are connected in series so that the current flows through them. The ideal ammeter has a resistance of zero so that it has no effect on the circuit.
Real ammeters have some internal resistance.
Voltmeters are connected in parallel to resistive
elements in the circuit so that they measure the potential difference across (on each side of) the element.
The ideal voltmeter has infinite internal resistance.
Our voltmeters have approximately 10 MΩ (10×106 Ω)
internal resistance so that only a minuscule amount of
current can flow through the voltmeter. This keeps the
voltmeter from becoming a significant path for current
around the element being measured.
Resistors are labeled with color-coded bands that indicate resistance and tolerance. The first two color bands
give the first two digits of the value (Fig. 15.3). The
third band gives the multiplier for the first two, in powers of 10. The last band is the tolerance (Fig. 15.3),
meaning the true value should be ±x% of the color
code value. Refer to Table 15.1 for standard color values.
There is no need to memorize the color codes for lab.
For example, a resistor that has two red bands and a
black multiplier band has a resistance of 22 Ω.

Figure 15.3: Color Code Schematic

Color

Number

Multiplier

Black

0

100

Brown

1

101

Red

2

102

Orange

3

103

Yellow

4

104

Green

5

105

Blue

6

106

Violet

7

107

Grey

8

108

White

9

109

Tolerance
Gold

5%

Silver

10%

(No Band)

20%

Table 15.1: Resistor Color Code Values
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Name:

1. Write the equation and a qualitative statement for Ohm’s Law. (20 pts)

2. What are “ohmic” and “non-ohmic” devices? (20 pts)

3. Complete the following statement: An ideal ammeter has an internal resistance of
ideal voltmeter has an internal resistance of

, while an

. Explain why these are desirable attributes for

the respective measuring instruments. (20 pts)

4. If I vs. V is plotted, what value is obtained from the slope? Note that we are investigating the function I = V /R
and fitting our data to the slope-intercept equation of a line. (40 pts)
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PROCEDURE
PART 1: Measures of Resistance
1. Determine the nominal resistance for the three resistors: interpret the color codes according to the
color code chart in Table 15.1.
2. Measure the actual resistance, R, of the three resistors using the ohmmeter and record them in the
table provided.
3. An ideal ammeter has no resistance; this ammeter
does have a small resistance. Measure the resistance
of the ammeter (200 mA DCA).

PART 2: Ohm’s Law Applied
4. Build a simple series circuit using R1 , an ohmmeter,
an ammeter, and a jumper (This will look similar
to Fig. 15.1, but without the power supply).
5. Measure the equivalent resistance of the circuit using the ohmmeter and record this value in the table
provided. Include units and uncertainty.

Figure 15.4: Spade Connection to Circuit Board

PART 4: Graphing

6. Remove the ohmmeter and connect the unplugged
power supply to the circuit. Connect a voltmeter to
the circuit, across the power supply leads (in parallel).

13. Open Graphical Analysis. Enter all of your voltage
and current data as four separate data sets (one for
each resistor). Include the point (0,0) in each set.
[Other graphing software may be used, provided the
graphs include all requisite elements.]

7. Have your TA check your circuit. Plug in the power
supply and turn it on.

14. Plot I vs. V for the three Ohmic resistors on one
graph. Apply a linear fit to each one.

8. Test Ohm’s Law (V = IR) by verifying that the
current increases linearly with applied voltage. Apply 1 V, 2 V, 3 V, and 4 V to the circuit. Measure
current and voltage and record them in the table
provided. Include units and uncertainty.

15. Calculate the resistance of each circuit using the
slope of your I vs. V graphs. Compare these Rgraph
values to the measured Req values using the percent
difference formula (Eq. C.1, Page 4).

9. Repeat the Part 2 procedure for R2 and R3 .

16. Plot a separate I vs. V graph for the light bulb.
17. Print a copy of both graphs.

PART 3: Non-Ohmic Device
10. Build a series circuit using R4 , the light bulb
(Fig. 15.4).
11. Measure the current and voltage as you increase the
applied voltage in 0.2 V increments up to 2.0 V,
then continue in 1.0 V increments up to 4.0 V. Adjust the voltmeter scale to obtain the most significant figures possible.
12. Turn off and unplug the power supply; turn off the
DMM’s.

Experiment 15: Ohm’s Law
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QUESTIONS
1. Read the information in the next column. How
much current would it take to cause pain? What
was the maximum current you measured for this
experiment?
2. Why was there no danger to you while you performed this experiment? The current required for
this experiment is as high as 30 mA. Some experiments will require current as high as 5.0 A. Explain
why there will be no danger to you. Read the information in the next column again, more carefully
if necessary.
3. Is the graph of I vs. V for the light bulb linear?
What does this tell you about the resistance of a
light bulb as the filament gets hotter?
4. Compare the experimental (DMM, graph) values for
each ohmic resistor.
5. Do the experimental values fall within the tolerance
of the resistors? What might cause the values to exceed the tolerance?
6. The power output of a circuit is given by:

P = I 2R =

V2
= IV
R

(15.2)

The resistors used in this experiment are 2-watt
resistors. What is the maximum power output of
R1 when 9.0 V is applied across it (use your graph
value)?
7. Calculate the power output of each ohmic resistor
(use your graph value) when a potential of 7.00 V
is applied.
8. Verify, using only the units provided in Table 14.1,
that each part of Eq. 15.2 is equal to J/s. What is
the unit of power output?

1 Hewitt,

Can voltage kill you?
It’s actually current that kills. So why are “Hazardous
Voltage” signs so prevalent? Paul Hewitt1 explains it
very nicely:
Consider Ohm’s Law: V = IR. What is
the resistance of your skin? That depends
on the state of your skin: dry or wet. If
it’s wet, is it water or sweat? Sweat, of
course, contains salt; salt water is a good
conductor.
The resistance will be dramatically different for different situations! Very dry skin
has a resistance of about 500,000 Ω, while
skin wet with salt water has a resistance
of about 100 Ω. Once the voltage of a device and your skin’s resistance are known,
we can estimate the current that will flow
through your body.

Current

Effect

0.001 A

Can be felt

0.005 A

Is painful

0.010 A

Causes involuntary
muscle contractions (spasms)

0.015 A

Causes loss of muscle control

0.070 A

If through the heart, causes serious
disruption; probably fatal if
current lasts for more than 1 second

Table 15.2: Effect of Electric Current on the Body
Note that the effect caused by these currents are approximate values. It is quite difficult to get volunteers
for this area of research!

Paul G., 2006. Conceptual Physics. Pearson Addison Wesley, San Francisco.
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Experiment 16: Series and Parallel
Circuits

Figure 16.1: Series Circuit

Figure 16.2: Parallel Circuit
83
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Figure 16.3: Combination Circuit
EQUIPMENT
Universal Circuit Board
(2) 100-Ω Resistors
(2) 200-Ω Resistors
(2) 300-Ω Resistors
(2) Digital Multi-Meters
Power Supply
(5) Jumpers
(6) Wire Leads

Experiment 16: Series and Parallel Circuits
Advance Reading
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resistor value. The current has more than one path
available and takes all available paths.

Text: Resistors in series, parallel, combination.

For a parallel circuit, the total equivalent resistance,
Req , is:

Lab Manual:
Appendix C
Appendix ?? - DMM

N

Objective
The objective of this lab is to study circuits with resistors connected in series, parallel, and combination and
to determine the internal resistance of an ammeter.

X 1
1
1
1
1
1
=
+
+
+ ··· +
=
(16.2)
Req
R1
R2
R3
RN
Ri
i=1
(Resistors in Parallel)

Theory
In the previous experiment, you constructed 4 circuits,
each circuit built with one resistive element. In this
experiment, you will construct circuits using multiple
resistors.
The first type of circuit you will construct is a series
circuit (Fig. 16.1 and Fig. 16.4). In a series circuit,
the resistors are connected end-to-end such that the
current is the same through each resistor: The current
has only one path available. The voltage drop across
each resistor depends on the resistor value.
For a series circuit, the total equivalent resistance,
Req is:

Req = R1 + R2 + R3 + · · · + RN =
(Resistors in Series)

N
X

Ri

(16.1)

i=1

Figure 16.4: Series Circuit Schematic
The second type of circuit you will construct is a parallel circuit (Fig. 16.2 and Fig. 16.5). Resistors are
said to be in parallel when they are connected to each
other at each end. In this way, the potential difference applied across the combination is the same as the
potential difference applied across an individual resistor. The current through each resistor depends on the

Figure 16.5: Parallel Circuit Schematic
The third type of circuit you will construct is a combination circuit (Fig. 16.3 and Fig. 16.6). Resistive
elements are not connected in series or parallel. To
calculate the total equivalent resistance of a combination circuit, it should first be simplified (reduced to an
equivalent resistor, Req ). This is done by choosing resistors that are connected in either series or parallel,
one step at a time, adding those elements by use of
Eq. 16.1 or Eq. 16.2, then proceeding to the next set
of elements.

Figure 16.6: Combination Circuit Schematic
Note that it is not correct to, for example, calculate
the resistance of the 3 resistors across the top of the
circuit using Eq. 16.1, and then calculate the resistance
of R4 , R5 , and R6 using Eq. 16.2. You must identify
which resistors are either in parallel or in series, then
apply the appropriate equation one step at a time.
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Name:
1. What is a series circuit? (10 pts)

2. What is a parallel circuit? (10 pts)

3. Is the equivalent resistance, Req , of a series circuit greater than or less than any individual resistor? (10 pts)

4. Is the equivalent resistance, Req , of a parallel circuit greater than or less than any individual resistor? (10 pts)

5. Calculate Req for each of the first three circuits shown in Fig. 16.4 - Fig. 16.6 using the stated nominal values
for resistance. (Show all work on back of this sheet.) (25 pts)

6. You will plot I vs. V for each of the three circuits on one graph. What value should each slope have (use the
stated values for resistance)? (25 pts)

7. Create Data Tables in your lab notebook for all parts of this experiment. Sketch the column headings on the
back of this sheet. (10 pts)

Experiment 16: Series and Parallel Circuits
PROCEDURE
PART 1: Series Circuit
Record all data in table format.
Recall that (i = 1, 2, . . . , n)
1. Measure Ri , then construct a series circuit
(Fig. 16.4) with 100-Ω, 200-Ω, and 300-Ω resistors
and ammeter (200 mA DCA); do not connect the
power supply yet.
2. Draw the schematic using measured Ri ’s.
3. Calculate Req .
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PART 3: Parallel Circuit
16. Repeat Part 1, Step 1 - Step 8, for the parallel circuit (Fig. 16.5).
17. Does V2 = V1 + VA , or does V2 = V1 = V3 ? Are
each of these values negative or positive?! Yes, it
matters!
18. Does V = |V1 + VA |?
PART 4: Combination Circuit
19. Repeat Part 1, Step 1 - Step 8, for the combination
circuit (Fig. 16.6).

4. Measure Req .
5. Connect the unplugged power supply and the voltmeter (DCV) to your circuit.
Get instructor approval of your circuit
6. Always be sure the power supply is turned off before you plug it into an outlet. Plug in the power
supply, and set the voltage to 1.00 V. Measure the
current and voltage.
7. Record the current (A) and the voltage (V) as you
increase the voltage in 1.0 V increments up to 4.0 V.
8. Leave the voltage at 4.0 V; disconnect the voltmeter
from the power supply. Maintaining the same orientation of the leads (if clockwise, black follows red),
measure Vi .
P
9. Add these potential differences ( i=1 Vi ).
P
10. Does i=1 Vi equal −4.0 V? If not, ask your TA for
guidance.
PART 2: Internal Resistance of an Ammeter

PART 5: Graphing
20. Graph I vs. V for each of the first three circuits on
one graph (Part 1, Part 3, and Part 4).
21. Part 5 of this experiment may also be on an exam.
Be certain you know how to produce a complete
graph. Ask for help if needed.
QUESTIONS
1. Why should the voltage drops (electric potential differences) across the resistors connected in parallel
be the same? Were your values equal?
2. Calculate the equivalent resistance of each of the
first three circuits you constructed for this experiment using your measured values. Show each step
in this process (math and schematic). Remember
to include RA in your calculations.
3. Consider your data from Part 2. Create a table similar to the one shown below. Why does Req change
when you change the scale of the ammeter?

11. Turn off, then unplug and disconnect the power supply and the ammeter from the circuit. (Note that
you will need to insert a jumper when the ammeter
is disconnected in order to complete the circuit.)

Ammeter Scale

12. Measure Req of the circuit.

20 µA

13. Insert the ammeter (scale: 200 µA DCA) in the
circuit.

200 µA

14. Measure Req .
15. As you change the scale of the ammeter, measure
Req for each of the ammeter scales (e.g., 2 mA,
20 mA). You will have a total of 8 Req ’s.

No Ammeter

2 mA
20 mA
200 mA
2A
20 A

Req

RA
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Experiment 17: Kirchhoff ’s Laws for
Circuits

Figure 17.1: Kirchhoff’s Law Circuit Board

Figure 17.2: Schematic for Kirchhoff’s Circuit

EQUIPMENT
(1)
(2)
(2)
(4)
(1)

(5) Resistors:
R1 = 10 Ω Resistor
R2 = 12 Ω Resistor
R3 = 15 Ω Resistor
R4 = 18 Ω Resistor
R5 = 22 Ω Resistor

Universal Circuit Board
D-Cell Batteries (1.5 V)
Battery Holders
Alligator Clips
DMM
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Advance Reading

Text: Kirchhoff’s Voltage Law, Kirchhoff’s Current
Law
Lab Manual: Appendix A: Math Review (solving 3
equations with 3 unknowns)
Objective
The objective of this experiment is to apply Kirchhoff’s
rules for circuits to a two-loop circuit to determine the
three currents in the circuit and the electric potential
differences around each loop.

Apply the following rules when writing a KVL equation for a loop:
• If a seat of emf is traversed from − to +, the
change in potential is +ε; if it is traversed from
+ to −, the change in potential is −ε. (Note that
you must maintain orientation as you progress
around each loop. ε1 is traversed from − to +,
while ε2 is taversed from + to −.)
• Current flows from high potential to low potential. Crossing a resistance with the current constitutes a negative potential difference. Measuring against the current yields a positive potential
difference.

Theory
The two basic laws of electricity that are most useful
in analyzing circuits are Kirchhoff’s laws for current
and voltage.
Kirchhoff ’s Current Law (KCL) states that at any
junction (node) of a circuit, the algebraic sum of all
the currents is zero (sum of the currents entering the
junction equals the sum of the currents leaving the
junction). In other words, electric charge is conserved.
ΣIin = ΣIout

(17.1)

Kirchhoff ’s Voltage Law (KVL) states that around any
closed loop or path in a circuit, the algebraic sum of
all electric potential differences is equal to zero.
ΣVi = 0

(17.2)

To calculate magnitudes of current and voltage in a
circuit like Fig. 17.2, you will need to write two equations, making use of KVL and Ohm’s Law. This results
in two equations with two unknowns. For this experiment, you will measure εi and Ri , then solve for the
two currents, Ii .
One might be able to guess the direction of current flow
in a circuit, given a circuit such as the one in this experiment. However, the current direction can be safely
ignored when using the loop method. For the purposes
of this experiment, all currents will be assumed to be
clockwise. If any current is measured or calculated to
be negative, that current actually flows counterclockwise in the circuit.

Figure 17.3: Potential Difference Sign Convention
Write an equation for each loop in terms of electric
potential difference. The electromotive force, emf (ε,
voltage source), is provided by a D-cell battery.
For example, the equation for the left loop in Fig. 17.2
is:
ε1 + V1 + V2 + V 3 = 0

(17.3)

Rewrite this equation using Ohm’s Law, then simplify:
ε1 − I1 (R1 + R2 + R3 ) + I2 R2 = 0

(17.4)

A similar equation is written for the right loop. Taken
together, the two loop equations can be solved for I1
and I2 by means of substitution. Theoretical potential
differences can then be calculated using Ohm’s law.

Prelab 17: Kirchhoff ’s Laws for Circuits

91

Name:
1. Write the equation, then briefly explain: (20 pts ea.)
(a) Kirchhoff’s Voltage Law (KVL)

(b) Kirchhoff’s Current Law (KCL)

2. Consider the circuit shown in Fig. 17.2 and the Equipment list on Page 89. Use Kirchhoff’s Voltage Law to solve
for the theoretical currents in each of the three branches of the circuit. Let us define two distinct loops of the
circuit with currents I1 and I2 .
Voltage sums for the left loop and for the right loop are written using KVL:
ε1 − V1 − V2 − V3 = 0

−ε2 − V4 − V5 + V2 = 0

(KVL - left loop)
(KVL - right loop)

In performing experiment, measured values will be used for εi and Ri . For the pre-lab, use the nominal values
as stated in the Equipment list. Recall that the electric potential difference, or voltage, across a resistor has the
same subscript as the resistor. For example, the voltage across resistor R6 is V6 . Use the back of this sheet for
Question 2.
(a) Rewrite the KVL equations using Ohm’s Law (e.g., V1 = I1 R1 ). (30 pts)

(b) Solve for I1 and I2 using substitution. Refer to Appendix A as necessary. (30 pts)
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PROCEDURE
PART 1: Loop Method - Calculations

1. Determine the nominal resistance and tolerance of
each resistor by reading its color code (Table 15.1,
Page 78). They should have the following approximate resistances:
R1
R2
R3
R4
R5

= 10
= 12
= 15
= 18
= 22

Ω
Ω
Ω
Ω
Ω

2. Measure the resistance of each resistor using an
ohmmeter.
3. Construct the circuit shown in Fig. 17.2. Do not
connect the ammeter.
4. Measure ε of the two batteries using a voltmeter.
They should each be at least 1.1 V. Turn off the
DMM and disconnect the batteries so they do not
drain.
5. Using your knowledge of Kirchhoff’s Voltage Law,
write two equations relating the potential differences across each element in the two loops. Remember that both currents flow through the central
branch of the circuit.
6. Solve these equations by substitution to find the
theoretical currents in each loop. A negative value
simply indicates the current flows in the other direction.

PART 2: Current & Voltage Laws Applied
7. Connect the batteries to the circuit.
8. Measure the current in each of the three branches of
the circuit. Refer to Fig. 17.4 for proper ammeter
connection technique. Disconnect the batteries and
turn off the DMM after measurement.
9. Compare the measured values of current with the
calculated values. If they are not approximately
equal, check your calculations or retest the circuit.
10. Reconnect the batteries and measure the electric
potential across each element of the circuit. Sign
and direction are crucial; measure clockwise, leading with the red lead and following with black.

Figure 17.4: Ammeter Connection
PART 3: Non-Ideal Voltmeter
At the front of the room, your TA has set up two
series circuits. One circuit has two 100 Ω resistors,
the other circuit has two 10.0 MΩ resistors. Take
your voltmeter to this table. Adjust the power supply on each circuit to 10.0 V.
11. Measure the potential differences across each of the
resistors in the 100 Ω circuit. Is the magnitude of
their sum equal to the potential difference across
the power supply? Show work.
12. Measure the potential difference across each of the
resistors in the 10.0 MΩ circuit. Is the magnitude
of their sum equal to the potential difference across
the power supply? Show work.

Experiment 17: Kirchhoff ’s Laws for Circuits
QUESTIONS
1. Explain what effect the DMM will have on the circuit when inserted to measure current.
2. Do the values from Part 2 verify Kirchhoff’s Current Law?
3. Do the values from Part 2 verify Kirchhoff’s Voltage
Law?
4. Would disconnecting the power supply on the left
loop of the circuit, ε1 , affect the current I2 (no
jumper inserted)? Calculate what I2 is for this case.
Comment on I3 .
5. A voltmeter is connected in parallel to a resistor
when measuring Vi . Remember that the internal
resistance of the DMM, when used as a voltmeter,
is approximately 10 MΩ. Calculate Req of the voltmeter connected to a resistor in each circuit of
Part 3.
6. Use the above information to discuss why the voltage measured across the 10 MΩ resistors did not
equal the voltage measured across the power supply.

93

94

Experiment 17: Kirchhoff ’s Laws for Circuits

Experiment 18: Earth’s Magnetic Field

Figure 18.1: Earth’s Magnetic Field - Note that each of the 3 elements of the circuit are connected in series. Note
the large power supply: large power supply → large current. Use the 20A jack and scale of the ammeter.

EQUIPMENT
Tangent Galvanometer
Ammeter (20A jack, 20A DCA)
Dip Needle
Large Power Supply
(2) 12” Wire Leads
(2) 36” Wire Leads

Figure 18.2: Earth’s B-Field Schematic
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Advance Reading
Text: Magnetic field, vectors, right-hand rule for a wire
loop, resistivity.
Objective
The objective of this lab is to measure the magnitude
of Earth’s magnetic field in the lab.
Theory
The magnetic field of Earth resembles the field of a bar
magnet. All magnetic field lines form a closed loop: a
field line originates at the north pole of a magnet, enters the south pole, then moves through the magnet itself back to the north pole. Although we usually think
of this field as two-dimensional (north, south, east,
west), remember that it is, in fact, a three-dimensional
vector field.

Figure 18.3
The direction of the magnetic field of a current carrying wire is given by the right-hand rule. When the
thumb of the right hand points in the direction of the
current (positive current; conventional current), the
fingers will curl around the wire in the direction of the
magnetic field. Refer to Fig. 18.3.

The horizontal component of the magnetic field of
Earth is typically measured using a compass. The needle of a compass is a small magnet, which aligns with
an external magnetic field. Recall that opposite poles
attract, and like poles repel. Thus, the north pole of
the compass needle points to the south magnetic pole
of Earth, which is sometimes close to the geographic
north pole.
We will measure the horizontal component of Earth’s
~ e , then use this information to demagnetic field, B
termine the magnitude of the total magnetic field of
~ t.
Earth, B
Determining the magnitude of an unknown magnetic
field can be accomplished by creating an additional,
known magnetic field, then analyzing the net field. The
magnetic fields will add (vector math) to a net magnetic field (resultant vector).
~ net = B
~ known + B
~ unknown
B

(18.1)

~ galv , will be produced by
The known magnetic field, B
use of a tangent galvanometer. A tangent galvanometer is constructed of wire loops with current flowing
through the loops. The current produces a magnetic
field. The magnitude of this magnetic field depends
on the current, the number of loops, and the radius of
each loop:
µ0 IN
(18.2)
Bgalv =
2r
where µ0 = 4π × 10− 7 Tm/A is the permeability constant, I is the current, N is the number of loops, and
r is the radius of the loop.

Figure 18.4
The coil of the tangent galvanometer is first aligned
with the direction of an unknown field, Be , or north.
The compass inside the tangent galvanometer allows
accurate alignment. Once current begins flowing, the
two magnetic fields will add (vector addition) to yield
a resultant magnetic field. The compass needle then
rotates to align with the net field. The deflection angle
α is the number of degrees the compass needle moves.
α is measured, and Be is calculated from:
Bgalv
= tan α
Be

(18.3)
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A typical compass is constrained to 2 dimensions and
rotates to point to Earth’s magnetic south pole, which
is (approximately) geographic north. Earth’s magnetic
field, however, is a 3 dimensional phenomenon. It has
components that point into and out of the earth, not
just along the surface. We need to measure at our location the direction of the total magnetic field of Earth
(the angle θ).
To determine field declination, θ, we will use a dip needle. A dip needle (Fig. 18.5 and Fig. 18.6) is a compass
that rotates. It measures both horizontal and vertical
angles.
First, arrange the dip needle in a horizontal position,
compass needle and bracket aligned, pointing north
(normal compass). Refer to Fig. 18.5, below, for clarification. The needle should align with 270◦ .

Figure 18.6: Dip Needle: Vertical Orientation

Figure 18.5: Dip Needle: Horizontal Orientation
Now rotate the compass 90◦ (Fig. 18.6) to a vertical
position. The needle rotates to a new angle; the difference between the initial angle and the final angle is
the angle θ.
From Fig. 18.6, we see that the dip needle points in
the direction of Earth’s total magnetic field at our location.

Figure 18.7

By determining the magnitude of the horizontal component of Earth’s magnetic field, Be , using α, and measuring the direction of Earth’s total magnetic field, Bt ,
using θ, the magnitude of Bt can be determined. (Refer to Fig. 18.7.)

Prelab 18: Earth’s Magnetic Field
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Name:
1. What physical phenomenon does the relationship Bgalv =

µ0 iN
2r

describe? (10 pts)

2. Explain the right-hand rule for current. (10 pts)

3. Consider Fig. 18.4. Determine the following in terms of B’s (Be , Bgalv , and Bnet ). (10 pts)
sin θ =
cos θ =
tan θ =
4. Consider Fig. 18.7. Determine the following in terms of B’s (Be , Bz , and Bt ). (10 pts)
sin α =
cos α =
tan α =
5. Given Be of 45 × 10−6 T and a dip angle of 55◦ , calculate Bz . See Fig. 18.7. (30 pts)
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6. Consider the top-view diagram of the tangent galvanometer, Fig. 18.11. Given the galvanometer’s alignment with
North, as shown, indicate the direction that current flows through the top of the wire loops. (30 pts)

Figure 18.8: Top View - Wire loops encircle compass.

Figure 18.9: Side View - Compass located inside wire
loops.

Figure 18.10: Tangent Galvanometer

Figure 18.11: Compass Needle
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PROCEDURE
PART 1: Horizontal Component
1. Connect the galvanometer (N = 5), ammeter (20A
DCA), and power supply in series.
2. Align the galvanometer such that it creates a magnetic field perpendicular to that of Earth’s field (the
compass needle should be parallel to the wire loop).
Do not move the galvanometer while taking data.
3. Turn on the power supply to flow current through
the galvanometer. Adjust the current until the compass needle on the galvanometer reaches 30◦ , 40◦ ,
and 50◦ , recording the current required for each position in the data table provided.
4. Repeat this process for N = 10 and N = 15 (a total
of nine trials).
5. Calculate the average horizontal field, Be , for each
of the nine trials using Eq. 18.2 and Eq. 18.3.
The diameter of the coils is approximately 20 cm.
[µ0 = 4π × 10−7 Tm/A]
6. Find the average value of Be from your nine trials.

Experiment 18: Earth’s Magnetic Field
PART 2: Field Declination
7. Use the dip needle to determine the direction of
magnetic north. Align the dip needle’s supporting
arm with its compass needle (pointing north).
8. Roll the compass arm 90◦ until the bracket is vertical (and still pointing north/south).
9. Record the declination of Earth’s magnetic field, the
angle θ from the horizontal.
10. Use this declination to calculate the magnitude of
the total magnetic field of the Earth, Bt , in the lab.
Refer to Fig. 18.7.

QUESTIONS
1. Calculate the total resistance of 10 loops of copper wire of the galvanometer if the wire is 1 mm
in diameter and the loops are 20 cm in diameter:
R = ρL/A. L is the length of the wire, A is the
cross-sectional area of the wire, ρ is the resistivity
of copper; look it up in your text, a CRC text, or
online.
2. Compare your measured Bt from this experiment
to a sample value of 43 µT. This is the magnitude
of the magnetic field in Tucson, Arizona.

Figure 18.12: If leads are plugged into the left and
middle jacks, N = 5, as indicated. If plugged into
the right and middle jacks, N = 10. If plugged into
the left and right jacks, N = 15.

Experiment 19: The Current Balance

Figure 19.1: Current Balance Arrangement for Varying Current or Length
From Left to Right: Power Supply, Current Balance Assembly, Ammeter (20A DCA scale, 20A jack). North pole of
magnet is red; south pole of magnet is white (standard). The magnetic field is from north to south (red to white).

Equipment
Pasco Current Balance Apparatus
Digital Balance
Large Power Supply
Current Limiting Resistor
(If new power supply, no resistor)
Ammeter (20A jack, 20A DCA)
(6) Wire Leads
Rod
Clamp

Figure 19.2: Schematic for Current Balance
(The current limiting resistor may be internal
to the power supply, as shown in Fig. 19.1)
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Advance Reading
Text: Magnetic force, magnetic field.
Objective
The objective of this experiment is to measure the effects of a magnetic field on a current carrying conductor.
Theory
~ B , on a moving
A magnetic field exerts a force, F
~
charge. The magnitude of FB is:
FB = qvB sin θ

(19.1)

where q is the charge, v is the magnitude of the velocity (speed) of the charge, B is the magnitude of the
magnetic field strength, and θ is the angle between the
direction of the magnetic field and the direction of the
charge velocity.
Current is a collection of charges in motion; thus, a
magnetic field also exerts a force on a current carrying
conductor.
The magnitude and direction of this force is dependent
on four parameters:
1. Magnitude of the current, I
2. Length of the wire, L
3. Strength of the magnetic field, B
4. Angle between the field and the current, θ
The magnitude of the magnetic force in this case is
given by:
FB = ILB sin θ

(19.2)

In this experiment, a current-carrying wire will be
placed between the two poles of a magnet. When current is flowed perpendicular to the magnetic field, the
wire and the magnet will either push or pull on each
other in the vertical direction. We quantify the force
on the wire using Eq. 19.2; by Newton’s Third Law,
the force exerted on the magnet will be equal and opposite.
The force on the magnet can be determined by measuring differences in the magnet’s apparent weight on
a scale as the current-carrying wire pushes it up or
down. While the scale gives readings of “mass,” the
associated “weight” or force, FB , can be calculated:
FB = mg

(19.3)

Current, wire length, and angle will be varied one at a
time, and magnetic force will be measured in order to
determine the magnetic field strength, B, of each magnet. Current and length will be varied for one magnet
(B1 ), then θ will be varied for a second magnet (B2 ).
Consider Eq. 19.2. At what angle is FB at a maximum
value? At what angle is FB at a minimum value?
When we investigate the force due to either a change
in current or a change in the length of wire, we will
want the maximum force. This allows us to compare
2 values for the magnetic field strength, B. We must,
therefore, be certain that the current carrying wire and
the magnetic field of the magnet are perpendicular to
each other (90◦ ). Refer to Fig. 19.1.
When we investigate the force due to a change in angle, we must find a way to be sure of our initial angle,
0◦ . What will FB equal if the wire and the magnetic
field are parallel? With this arrangement, a non-zero
current will result in a force of 0.0 N. If the balance
has a non-zero mass reading, we know that the wires
and the field are not parallel.
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Name:
1. What physical phenomenon does the relationship F = qvB sin θ describe? (15 pts)

2. What physical phenomenon does the relationship F = ILB sin θ describe? (15 pts)

3. Magnetic force is dependent upon what four factors for this experiment? (15 pts)

4. In this experiment you will plot four sets of data (refer to Part 19 of the procedure). Sketch a sample plot for
each data set on the back of this sheet. You will not need numerical values. Label the axes. State the slope in
algebraic terms. (35 pts)

5. Consider the apparatus below. It represents a magnet sitting on the mass pan of a balance. Refer to Fig. 19.1
and Fig. 19.3 (Step 3 of the experiment). Given the following setup, does the balance read heavier or lighter?
Explain using the right-hand rule and Newton’s Third Law. (20 pts)
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PROCEDURE

attracted (pulled upwards; negative mass reading),
reverse the wires connected to the power supply,
turn off the balance, and start again from Step 1.

PART 1: Force vs. Current (∆I)
1. Build the circuit as shown in Fig. 19.2 using the
current loop numbered SF 42.
2. Locate the magnet for the wire loops, B1 (Fig. 19.3),
and center the magnet on the balance pan. On the
digital balance, there is a “Zero” button. Push this
button once to “tare” the balance (zero it).
3. Lower the balance arm so the wire loop passes
through the pole region of the magnet (i.e., the horizontal section of the wire is just below the top edge
of the magnet, Fig. 19.3). Note that this will result
in the wire loop and the slot of the magnet being
parallel.

6. Measure m and I.
7. Repeat this procedure as you increase the current
in 0.5 A increments through 5.0 A.
8. When data collection is complete, turn off the power
supply and DMM.
9. Unplug the power supply.
10. Calculate FB for each current value (Eq. 19.3).

PART 2: Force vs. Length of Wire (∆L)
Note: For this part of the experiment, you will need
to know the effective length of the wire loops, which
is listed in Table 19.1, below:

SF
SF
SF
SF
SF
SF

40
37
39
38
41
42

1.2
2.2
3.2
4.2
6.4
8.4

cm
cm
cm
cm
cm
cm

Table 19.1: Wire Lengths

Figure 19.3: Wire Loop Arrangement
Once you begin this experiment, do not move the
equipment on the table, although you will raise and
lower the balance arm to change attachments.
You will need to verify, before each reading, that
the wire loop is in the appropriate position.
4. Refer to Fig. 19.1 and Fig. 19.2 to verify that you
have the circuit built correctly. Get instructor approval of your circuit. Be sure the power supply is
turned off before you plug it in.
5. Plug in the power supply. Adjust the power until the current is approximately 0.5 A. When the
current is on, the magnet should be repelled (deflected downward; positive mass reading). If it is

11. Insert the shortest wire segment (i.e., SF 40) into
the balance arm. Always verify that the wire loop
is in the appropriate position before recording measurements.
12. Set the current to 2.5 A. Measure m.
13. Repeat for each of the wire loops.
14. Turn off the power supply and the DMM.
15. Unplug the power supply.
16. Calculate FB .
17. Return the wire loops and magnet to their box. The
balance arm is used for Part 3 with the Current Balance Accessory (CBA, Fig. 19.4).
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PART 3: Force vs. Angle (∆θ)
18. Center the variable-angle magnet, B2 (Fig. 19.6),
on the balance pan and tare the balance.
19. Plug the CBA into the balance arm. Adjust the
height of the CBA as needed and lower it into the
magnet.
20. The horizontal section of the wire loops must be
just inside of, but not touching, the top edge of the
magnet (Fig. 19.6).
21. Turn the CBA to 0◦ (Fig. 19.5).
22. Initially, the horizontal section of the wire loops of
the CBA must be parallel to the magnetic field of
the permanent magnet. If they are parallel and current is flowing, FB = 0.0 N , and the mass measurement will not change. If the mass changes when
the current is turned on, adjust the alignment by
carefully rotating the balance.

Figure 19.5: Top view of CBA

23. When you have the correct arrangement, turn the
CBA from 0◦ through 180◦ , checking to see that it
will not hit the magnet at any point.
24. Return the CBA to 0◦ .

Figure 19.6: Close-up of CBA: Wire Loops Inside
Magnet; Assume L = 11.5 cm for CBA

25. Set the current to 2.5 A.
26. Measure m as you increase θ in 10◦ increments
through 180◦ .
27. Turn off the power supply and DMM.
28. Unplug the power supply.
Figure 19.4: Current Balance Accessory (CBA) Arrangement for varying θ

29. Calculate FB for each θ.
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PART 4: Analysis
30. Plot separate graphs of the following data; one data
table with 4 data sets. Determine if (0,0) is a valid
data point for each data set. When analyzing your
graphs, for B2 assume that L = 11.50 cm.
• FB vs. I
• FB vs. L
• FB vs. θ (File ⇒ Settings: Change radians to
degrees). Apply a curve fit under Analyze ⇒
Curve Fit (consider Eq. 19.2 when selecting an
appropriate fit)
• FB vs. sin θ
QUESTIONS
1. Show that Eq. 19.1 and Eq. 19.2 have equivalent
units.
2. Is the relationship between current and magnetic
force linear?
3. What is the relationship between the length of a
wire and magnetic force?
4. What is the shape of the curve for FB vs. θ? How
does it relate to Eq. 19.2?
5. Calculate and compare B1 and B2 from their respective graphs.

Experiment 20: Exponentials and
Oscilloscopes
EQUIPMENT
Universal Circuit Board
(1) 680 kΩ Resistor
(4) Jumpers
(1) 47 µF Capacitor
(4) Wire Leads
Digital Multi-Meter (DMM)
Power Supply
Stopwatch

Figure 20.1: Part 2: RC Circuit

Figure 20.2: Exponential growth general equation is N = N0 eλt
Exponential decay general equation is N = N0 e−λt
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Advance Reading (Exponentials)

The data for our exponential curve will be obtained by
measuring the potential difference across the resistor of
an RC circuit as a function of time.

Text: Exponential decay, RC circuit
Lab Manual: Appendix C
Objective
The objective of Part 2 is to investigate an exponential
curve by analysis of an RC circuit. Our RC circuit will
be a resistor R and a capacitor C connected in parallel.
Theory
When the rate of change of a quantity is proportional
to the initial quantity, there is an exponential relationship.
An exponential equation is one in which e is raised to
a power. e is the irrational number 2.7182818. . . .
An exponential equation has the form:
A(t) = A0 eBt + C

(20.1)

where A is the amount or number after a time t and
A0 is the initial amount or number.
Exponential rates are found everywhere in nature.
Some examples include exponential growth (e.g., population of Earth) and exponential decay (e.g., decay of
radioactive elements), as well as heating and cooling
rates.
Analysis of exponential curves often involves the
doubling-time or half-life (T1/2 ). Doubling-time is the
time required for an initial amount to double in quantity (what is t when A = 2A0 ?). The half-life is the
time required for 1/2 of the initial amount to be gone
(what is t when A = 12 A0 ?).
Analyzing these curves is often simple. For doublingtime or half-life, begin with the appropriate value on
the y-axis. Then draw a horizontal line that intersects
the plot. Next, drop a perpendicular line to the x-axis.
Read the value of the time directly from the x-axis.

A capacitor is connected in parallel with a resistor,
then charged to some initial voltage. When the power
supply is disconnected, the potential difference across
the capacitor will decrease exponentially. The voltage,
V , across the capacitor as it discharges is given by:
Vt = V0 e−t/RC

(20.2)

where V0 is the initial potential difference across the
capacitor at time t0 , R is resistance, and C is capacitance.
Consider Eq. 20.2. When t = RC,
1
(20.3)
e
We define τ (Greek letter, tau) to be the time it takes
for the voltage to drop to (1/e) · (V0 ) its original value
(about 37%). This is the value when τ = RC.
Vt = V0 e−1 = V0

For our discharging capacitor:
A graph of Voltage vs. Time is an exponential decay
curve. Analysis of this curve provides the time constant by locating the point at which V has dropped to
1/e its original value of V0 .
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Figure 20.3: Digital Oscilloscope (Part 1)
Part 1 EQUIPMENT
Circuit Gear Digital Oscilloscope
Oscillator
BNC Cable
DMM
BCN - Coaxial Adapter
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Advance Reading (Oscilloscopes)

Voltage

Text: Wavelength (λ), frequency (f ), and period (T ),
oscilloscope, EKG.

We will generate a periodic function (a sine wave; AC
voltage) for Part 1 using an oscillator. Note that a sine
wave has an amplitude of equal magnitude both above
and below zero, resulting in an average value of zero.
To obtain a meaningful value for this AC voltage, we
calculate the root-mean-square, rms, of the voltage.

Objective
The objective of Part 1 is to become familiar with oscilloscopes by measuring various quantities using an
analog oscilloscope and a digital oscilloscope.
Theory
An oscilloscope is a measuring device that plots Voltage vs. Time. When a signal is received by the oscilloscope, a trace (line) appears on the screen. The signal
could be generated from an oscillator, a tuning fork,
or a heart monitor at the doctor’s office.
The screen of an analog oscilloscope has a grid,
or gradecule, superimposed on it (Fig. 20.4). The
gradecule is used as a reference to read information
from the screen of an oscilloscope. The controls of an
oscilloscope will adjust the view of an incoming signal;
they will not adjust the signal itself.

Refer to Fig. 20.5. We will determine, from the trace,
the number of DIVISIONS for both the peak-to-peak
voltage (y-axis) and the time required for one wavelength (x-axis).
Vmax is the amplitude of the wave (half of the peakto-peak voltage).
The rms voltage, Vrms , is given by:
r
(Vmax )2
= 0.707Vmax
(20.4)
Vrms =
2
Recall that once the period T of a cyclic function is
known, the frequency f is given by:
T =

1
f

Figure 20.4: Gradecule
Figure 20.5: Gradecule Sample

(20.5)
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Name:
Exponential Curve
1. Refer to Fig. 20.2. Consider the equations:
y = Ae(C·x) + B
N = N0 e(λt)
What is N0 [i.e. Nt=0 ]? (You may read the information directly from the auto-fit box.) (10 pts)
2. Refer to Fig. 20.6, below. The doubling-time is the time it takes for the initial number or amount to double.
What is the doubling-time (N = 2N0 )? (Find the value on the y-axis, then move horizontally until you intersect
the plot. Drop a perpendicular line to the x-axis and read the time.) (20 pts)

Figure 20.6: Exponential Growth
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Radioactive Decay - Carbon Dating (30 pts)

Assume Fig. 20.7 represents 100% of the carbon found in all living matter. Carbon 14 (14 C) has a half-life (T1/2 )
of 5,730 years. The square represents a sample of 14 C. 14 C emits β − particles.
3. Divide the square in half with a vertical line and write “5,700 yrs” (rounded for simplification) on the left side,
to represent the amount of 14 C decayed after its half-life of 5,700 years (T1/2 = 5, 700 yrs).
4. Now divide the right side in half with a horizontal line and write “11,400 yrs” to represent the amount of
decayed after an additional half-life.
5. Continue to divide the remaining sample in this manner to show the amount of
22,800 yrs; 28,500 yrs; 34,900 yrs; and 45,600 yrs.

Figure 20.7: Carbon Dating Square

14

14

C

C decayed after 17,100 yrs;

Prelab 20: Exponentials and Oscilloscopes
Analog Oscilloscope
6. Define frequency, wavelength, and period. (10 pts)

7. What does an oscilloscope plot? (10 pts)

8. Determine the period and peak-to-peak voltage of Fig. 20.8, below (refer to Fig. 20.4). (20 pts)
Assume each major box is 12 V on the vertical scale and 12 ms on the horizontal scale.

Figure 20.8
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PROCEDURE
PART 1: Oscilloscopes

1. Connect the oscilloscope to the computer. Open the
Syscomp Circuitgear software on the desktop.
2. Plug in the oscillator and connect the output to the
oscilloscope, as in Fig. 20.3. The signal has been set
for you. You may shift the waveform by dragging
the A, B, or X cursors at the edge of the gradecule.
The horizontal and vertical scales can be adjusted
by using the Timebase Controls and Vertical Controls, respectively.

8. Connect the oscillator to the DMM using a BNC Coaxial adapter. Set the DMM to 20V ACV (instead of DCV) to measure root-mean-square voltage.
9. Record the frequency, f , of the signal by reading
the oscillator display.
10. Reconnect the BNC cable to the oscilloscope. Turn
off the oscilloscope, oscillator, and DMM.

3. Measure the peak-to-peak voltage of your trace (refer to Fig. 20.9). Note the VOLTS/DIV scale onscreen under Vertical Controls. You can use the
measurement tool under View ⇒ Toggle Channel
A Cursors to facilitate more accurate measurement.
Record this value in the table provided.
4. Calculate Vmax (do not measure).
5. Calculate Vrms (Eq. 20.4).
6. Measure the period, T , of your trace. Note the
SEC/DIV scale onscreen under Timebase Controls.
You can use the measurement tool under View ⇒
Toggle Time Cursors to facilitate measurement.
7. Use your measurement of period to calculate the
frequency of the signal (Eq. 20.5).

Figure 20.10: BNC - Coaxial Adapter

Figure 20.9: Gradecule Sample

Experiment 20: Exponentials and Oscilloscopes
PART 2: RC Circuit
The capacitors are electrolytic.
They must be
connected with the negative end of the capacitor on the negative side of the power supply;
failure to do so will damage the capacitor.
Refer to Fig. 20.11
11. Determine the nominal resistance of R1 . Then measure R1 with the DMM. Record these in the table
provided.
12. Measure the capacitance, C, of the capacitor using
the DMM at the TA’s table. Take care not to plug
it in backwards - this will damage the capacitor.
13. Construct the circuit shown in Fig. 20.11. Connect,
but do not plug in, the power supply.
14. Measuring voltage with a voltmeter changes the
equivalent resistance of the circuit. To account for
this, calculate Req of the resistor in parallel with the
10 MΩ voltmeter. Use the measured value of R1 .
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15. Calculate the theoretical value of the time constant
τ using Req and C.
16. Ask your TA to approve the circuit. Plug in and
turn on the power supply. Charge the capacitor by
applying 10.0 V across the circuit.
17. Disconnect one power supply lead from the circuit.
Take voltage measurements every five seconds for
three minutes. [The voltage should drop to the mV
range, requiring you to adjust the voltmeter scale
twice. If voltage drops to zero, check your circuit.]
18. Disassemble the circuit. Turn off the DMM.
PART 3: Graphing
19. Graph V vs. t using Graphical Analysis. Analyze
the curve using a natural exponent fit. Determine
the time constant from your curve fit. Print the
graph.

Figure 20.11: RC Circuit Schematic

QUESTIONS

Part 2

Part 1

4. Show that the product of RC has units of seconds.

1. Compare the two f values (oscilloscope and oscillator).

5. If an RC circuit has τ = 15 seconds, how long would
it take for the circuit to discharge to 1/e7 its original
value?

2. Compare the two Vrms values (oscilloscope and
DMM).

6. Calculate τ for an RC circuit consisting of a 3 µF
capacitor and a 1.5 MΩ resistor.

3. Given Vpeak−to−peak = 18.54 V, calculate Vrms .
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Experiment 21: Geometric Optics

Figure 21.1: Geometric Optics Equipment

Figure 21.2: Mirror Placement: The “Plexi-Ray Kit” contains a small piece of cork or plastic to stabilize the mirror
during your experiment. The mirror must sit on the paper, not on the stabilizer.
EQUIPMENT
Plexi-Ray Kit
Corkboard
Paper (9 sheets per 2-member team)
(2) Protractors
(2) 30-cm Rulers
(2) White Pins
(2) Color Pins
Lens Cleaning Towelettes (TA’s Table) - optical elements may need to be cleaned
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Advance Reading
Text: Geometric optics, law of reflection, law of refraction, index of refraction, total internal reflection, critical angle, parallax, real image, virtual image, speed of
light.
Objective
The objective of this experiment is to study the behavior of light using the ray model.
Theory
We will investigate light reflecting from objects as well
as light that is transmitted through objects.
An image viewed in mirror is a virtual image as are
images for some lenses. Light rays do not actually
pass through a virtual image. A virtual image cannot
be projected on a screen. The image seen in a mirror
does not appear to be at the surface of the mirror, but
rather to be located some distance behind the surface.
The image appears to be located the same distance
behind a plane (flat) mirror as the object is in front
of the mirror. We investigate virtual images for plane
mirrors in Part 1 and Part 2 of this experiment; we
will investigate virtual images from a lens in Experiment 22.
The Law of Reflection states that when light reflects
from a smooth, flat surface (e.g., a plane mirror), the
angle of incidence equals the angle of reflection:
θi = θr

(21.1)

In geometric optics, all angles are measured with respect to the normal (the perpendicular). We investigate this law in Part 3 of this experiment.
When light passes from a vacuum into a transparent
medium, it slows down. The ratio of the speed of light
in a vacuum, c, to the speed of light through a transparent medium, v, is the index of refraction, n, of
that medium. n ≥ 1 at all times, since:
n=

c
v

(21.2)

The speed of light in a vacuum, c, has been defined:
299,792,458 m/s, or approximately 3 × 108 m/s. Note
that each material has its own index of refraction; n is
a property of the medium.

Figure 21.3: Refraction
The Law of Refraction (Snell’s Law) describes the
behavior of a ray of light that passes from one medium
into another:
n1 sin θ1 = n2 sin θ2

(21.3)

where n1 and n2 are the indices of refraction for the
two media, θ1 is the angle of incidence, and θ2 is the
angle of refraction. We investigate the law of refraction
in Part 4 of this experiment.
Total Internal Reflection is a special case in which
light is unable to cross the boundary between the two
media. Consider Eq. 21.3 and a specific combination of
media, such as glass and air, with light passing through
a medium of higher n (n1 ) into a medium of lower n
(n2 ). As θ1 increases, θ2 increases more rapidly. θ1
can reach a value that results in θ2 being equal to 90◦ .
When this happens, the light will not exit the medium.
It will be totally internally reflected. This θ1 angle is
called the critical angle, θC :
θ1 = θC when θ2 = 90◦

(21.4)

Note that each combination or media can have a different θC . Note also that total internal reflection only
happens when light passes from a medium of higher
index of refraction into a medium of lower index of
refraction. Total internal reflection is a part of our everyday world - fiber optics, for example, used for cable
TV. We investigate total internal reflection in Part 5
of this experiment.

Experiment 21: Geometric Optics
Parallax is the effect whereby the position or direction
of an object appears to differ when viewed from different positions. This means that the object and the two
observations points are not collinear. Fig. 21.4 and
Fig. 21.5 represent the effect.
The apparent change in direction can be useful for determining the distance from Earth to a star. The diagram below is, of course, not to scale.
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Parallax is larger when the object is closer. While
parallax can present problems when making measurements, it is very useful for determining the position of
a virtual image.
Consider two objects that are aligned from your initial position (they appear to be one object). When
you change your position, each object will appear to
be displaced but by a different amount. The objects
appear to separate (Fig. 21.5). They are no longer
aligned with your position.

Figure 21.5: Parallax - Two Objects
We make use of parallax (2 objects) in Part 1 and, if
you so choose, Part 2 of this experiment.

Figure 21.4: Parallax - One Object

Since a virtual image cannot be projected on a screen,
it can be difficult to determine its location. Consider
an object whose image is observed in a mirror. The
image is a virtual image. To determine the position
of a virtual object, one can align a real object (pin)
with a virtual object (image of a different pin). If the
observer changes their position and the two objects do
not separate, the real and virtual objects are in the
same location.
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Name:
1. State the law of reflection. Write the equation. (10 pts)

2. State the law of refraction. Write the equation. (10 pts)

3. What is the definition of a virtual image? (10 pts)

4. What is total internal reflection? (10 pts)

5. Define critical angle. (10 pts)

6. Define parallax. (10 pts)

7. Write Snell’s Law. Using Eq. 21.4, derive the equation for the critical angle: θC =

. (40 pts)

Experiment 21: Geometric Optics
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PROCEDURE
1. Read through Step 6 before beginning. All arrangements (paper) should be aligned with the edge of
the table.
2. Measure all normal lines with a protractor to ensure
they are 90◦ ; do not estimate. Draw the lines long
enough to allow accurate measurements using the
protractor. Do not fold the paper!
3. When placing more than one pin, separate them as
much as possible (e.g., one pin close to the mirror, the other pin close to the edge of the paper).
This will increase accuracy and improve your results. When aligning objects and images, close one
eye.

PART 1: Parallax
4. For Part 1, you will use a virtual image (the mirror
image of a pin); use the image of the white pin as
the first object and a real object (a color pin) as a
second object. If the second object is placed at a
location other than the location of the first object,
note that when you change your position there is
a shift in the apparent position of the two objects.
You will see two images (Fig. 21.5); they will not
be aligned.
5. When parallax occurs, there are two possibilities:
• The pin is in front of the virtual image. Parallax is larger for the pin.
• The pin is behind the virtual image. Parallax
is smaller for the pin.
6. If the pin is placed at the same location as the virtual image and you change your position, there will
be no change in the apparent position of the two
objects (i.e., there will be no separation of the objects). You will see only one image, thus eliminating
parallax.

Figure 21.6: Parallax
7. Refer to Fig. 21.6. Draw a line across the center of
a sheet of paper (baseline) and a line normal to the
baseline down the center of the paper.
8. Place the paper on the corkboard and place the
back of the mirror on the baseline (Fig. 21.2). Place
a white pin midway on the normal in front of the
mirror. The image of this pin will be object 1.
9. Place a color pin on the normal behind the mirror.
This pin will be object 2.
10. Observe from an orientation to the right or left of
the normal. If object 1 and object 2 are not aligned,
move object 2 towards or away from you, along the
normal, until they are aligned. (Your partner will
help you stay on the normal.)
11. Measure and record the distance from the mirror to
the white pin, d0 , and the distance from the mirror
to the second pin, di .

Experiment 21: Geometric Optics
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PART 2: Image from a Mirror
12. Team performs once; take turns for each vertex.
13. Refer to Fig. 21.7. Draw a baseline across the center
of a sheet of paper. Place the triangular plexiglass
in the center of the front half of the paper, trace
around it, then return it to the kit. Label the vertices of the triangle A, B, and C. Place the paper
on the corkboard and the mirror on the baseline.
14. You may use either the parallax method or the following method to determine the position and dimensions of the virtual image of the triangle.
15. Consider Fig. 21.7. Two points are required to designate a particular line (e.g., two a′ or two a′′ ).
(Always separate the pins as much as possible to
improve your results.) Two intersecting lines designate a particular point (e.g., A′ ).

16. Place a white pin at vertex A; the image of the
white pin is the object. Observe from the left and
align two color pins (sighting pins) with the object.
17. Mark the positions, then remove the pins and label
the positions of the sighting pins a′ .
18. Repeat, observing from the right. Mark the sighting
pin positions as a′′ .
19. Repeat for vertices B and C (obtaining two sight
lines for each vertex).
20. Draw a line through the two a′ points, the length
of the paper. Repeat for each pair of points. Mark
the intersection of the a′ and a′′ lines as A′ . Repeat
for B ′ and C ′ .
21. Connect the points A′ , B ′ , and C ′ . Measure and
compare the dimensions of the object and image
triangle.

PART 3: Reflection
22. Refer to Fig. 21.8. Draw a baseline across a sheet
of paper, near the top. Draw a line normal to the
baseline down the center of the paper. Draw a line
to the left of the normal (incident line) with angle
θi between 25◦ and 35◦ .

Figure 21.7: Image from a Mirror

Figure 21.8: Reflection

Experiment 21: Geometric Optics
23. Place the two white pins on the incident line. Label
these positions P1 and P2 .
24. Look at the mirror from the right side of the normal
so that you can see the image of the first two pins.
Adjust your position so that the images of the white
pins are aligned; align two color pins with them.

123
• Situation B : As light enters the air from the
plexiglass, it bends away from the normal,
since it enters a medium with an index of refraction lower than the index of refraction of
the medium it is leaving.
36. Therefore, θ1 = θ2′ and θ2 = θ1′ . (nair = 1.0003)

25. Label these two points P3 and P4 .

37. Calculate the index of refraction of the plexiglass
for each situation (situation A and A′ ).

26. Draw a line connecting point P3 and P4 to the baseline. Measure and record θi and θr .

38. Average your values of nplexiglass and calculate the
speed of light through the plexiglass.

PART 4: Refraction
27. Place the plexiglass square at the center of a sheet
of paper and trace around it.
28. In the upper-left corner of the traced square, draw
a line normal to the square, about 2 cm from the
corner (Fig. 21.9).
29. Draw an incident line (θ between 25◦ and 35◦ ).
Place the paper on the corkboard, the square on its
traced outline, and two white pins on the incident
line. Label their positions P1 and P2 .
30. Look through the plexiglass square from the edge
opposite the pins and close your left eye. (It will
help if your partner holds a piece of paper behind
the square to block images of other objects in the
room.)
31. Adjust your position until the two white pins are
aligned, then place two sighting pins (color pins)
that align with the image of the two white pins.
Label these points P3 and P4 .

Figure 21.9: Refraction - Initial

32. Draw a line connecting P3 and P4 to the edge of the
square. Draw a line normal to the square through
this intersection (refer to Fig. 21.10).
33. Draw a line inside the square to connect the normals
(Fig. 21.10).
34. Measure and record each θ. You have 2 sets of data,
A and A′ (top and bottom).
35. Consider the law of refraction and Fig. 21.10.
• Situation A: As light enters the plexiglass from
the air, it bends towards the normal, since
it enters a medium with an index of refraction greater than the index of refraction of the
medium it is leaving.

Figure 21.10: Refraction - Final

Experiment 21: Geometric Optics

124
PART 5: Total Internal Reflection
39. Place the plexiglass triangle in the center of a sheet
of paper and trace around it. Draw a line normal to
the bottom edge (the long side), about 1 cm from
the left corner (Fig. 21.11). Place the paper and
triangle on the corkboard; place two white pins on
the normal line with their positions labeled P1 and
P2 .
40. Look through the right side of the bottom edge of
the triangle and adjust your position until the two
white pins are aligned. (It will help if your partner
holds a piece of paper behind the triangle to block
images of other objects in the room.) Now align two
color pins with the white pins as viewed through the
plexiglass. Label these position P3 and P4 .
41. Return the triangle and pins to the kit; place the
paper on the table.
42. Draw the path of the light ray by:
• Extending the normal (P1 P2 ) to the far edge
of the triangle
• Connecting P3 and P4 , extending the line to
the far edge of the triangle
• Connecting the line segments (P1 P2 to P3 P4 )
at the top (far edges of the triangle)
43. Draw a line normal to the edge of the triangle where
each light ray (P1 P2 and P3 P4 ) intersects the far
edge of the triangle.
44. Measure θ1 and θ2 at each location where the light
reflects internally. You have two sets of data, A and
A′ (right and left).

Figure 21.11: Total Internal Reflection

QUESTIONS
1. Calculate θC for plexiglass in air (using your average value of “n” from Part 4).
2. What is the shortest height a plane mirror must be
so that a person who is 1.6 meters tall is able to
see his or her whole body? Draw a ray diagram to
support your answer.

Experiment 22: Thin Lenses

Figure 22.1: Optical Bench Arrangement
EQUIPMENT
Optical Bench
(2) Lens Holders
(4) Optical Bench Clamps
Object Box (Light Source)
Small Screen
Large Screen (clipboard, paper)
Bi-Convex Lens (Converging Lens)
Bi-Concave Lens (Diverging Lens)
30-cm Ruler
Flashlight (1 per person)
Lens Cleaning Towelettes (TA’s Table)
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Advance Reading
Text: Thin lenses, converging lens, diverging lens, lens
equation, object distance, image distance, refraction,
focal length, magnification, index of refraction, real
image, virtual image.

to the optical axis refract towards the normal and focus at a point (small area) called the focal point, F .
The distance between the center line of the lens and
the focal point is the focal length, f . Refer to Fig. 22.2.
Fig. 22.2 through Fig. 22.6 are courtesy of Giancoli’s
Physics 1 .

Objective
The objective of this experiment is to measure the focal lengths of a converging lens and a diverging lens
and investigate magnification.
Theory
Light refracts (bends) when passing through media
with difference indices of refraction. This property can
be very useful, especially when a thin lens is used. A
thin lens’ thickness is much less than its diameter.
A converging (convex, positive) lens is thicker in the
center than at the edges. It can be used to focus
parallel light rays and form a real image as the light
travels from air to glass and back to air (nair ≈ 1.0,
nglass ≈ 1.5). A real image is formed by light actually passing through the image. A real image can be
projected on a screen. The image exists regardless of
whether or not a screen is in position to show it.
A diverging (concave, negative) lens normally forms a
virtual image. Light rays do not actually pass through
a virtual image. It cannot be projected on a screen.
When you look at yourself in a mirror, you are looking at a virtual image. If the object is real, the image
is virtual. However, when a diverging lens is used in
combination with a converging lens, for instance, the
object can be virtual, the image real. Parameters must
be met for a real image to be formed; read the Part 2
procedure carefully.

Figure 22.2: Ray Tracing: do → ∞, di ≡ f

For a converging lens, rays of light that are parallel to
each other but not parallel to the optical axis will still
refract towards the normal, but will focus at the focal
plane.

An important property of a lens is its focal length, f .
The focal length of a thin lens is given by:
1
1
1
+
=
(22.1)
do
di
f
where do is the object distance and di is the image
distance. These distances are measured from the lens.
Consider Eq. 22.1. For an object that is infinitely far
away (do → ∞).
Rays of light from an object very far away from a thin
lens will be approximately parallel when they reach
the lens. The light rays will then refract as they pass
through the lens. For a converging lens, rays parallel
1 Giancoli,

Figure 22.3: Ray Tracing: Focal Plane

Douglas C., 2005. Physics, 6th Edition. Pearson Education, Inc., Upper Saddle River, NJ.

Experiment 22: Thin Lenses
Rays of light from a nearby object will arrive at the lens
at various angles. The light rays will then refract as
they pass through the lens and, for a converging lens,
form an image at a distance di (refer to Fig. 22.4).
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Lateral magnification, M , is defined as the ratio of
the image height, hi , to object height, ho . The object height is assumed to be positive; the image height
is positive if the image is upright and negative if the
image is inverted.
hi
M=
(22.2)
ho
Magnification is also proportional to the relative distances of object and image from the lens:
M =−

Figure 22.4: Ray Tracing: Nearby Object
As mentioned, a diverging lens will usually form a virtual image. The image can be seen but cannot be
projected onto a screen.

Figure 22.5: Ray Tracing: Diverging Lens
To determine the focal length of a diverging lens in lab,
we will need to use two lenses. The real image from
the converging lens will become the virtual object for
the diverging lens. Refer to Fig. 22.6; although our
arrangement must be somewhat different than shown
below, the figure has the same concept we require.

Figure 22.6: Ray Tracing: Combination Lenses

di
do

(22.3)

The sign conventions for object distance and image
distance remain the same. These are calculated as in
Eq. 22.4 and Eq. 22.5.
The lab will be dark (lights off) for the remaining experiments this semester. It is important that your
flashlight be pointed below horizontal at all times. This
limits the bleaching of visual purple, which permits
night vision. Please turn off the flashlight when it is
not in use and before you leave lab.
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Name:
1
1. Define the terms of the relationship d
o

+

1
di

=

1
f (Eq. 22.1) and state how each term is measured. (20 pts)

2. State the sign conventions for do and di . (20 pts)

3. What is the difference between a real image and a virtual image? (20 pts)

4. Define the terms of the relationship

M=

hi
ho

and state the sign conventions. (20 pts)

5. What does optical axis mean? (10 pts)

6. What two methods will be used to calculate the focal length of a converging lens? (10 pts)
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Method II - Use a distant object (do → ∞)

PROCEDURE
PART 1: Converging Lens
Method I - Use the lens equation (Eq. 22.1)
1. Refer to Fig. 22.1. Mount the lens, screen, and light
source on the optical bench. Adjust the height of
the object, lens(es), and screen so that the optical
axis passes through the center of each element.
2. Adjust the position of the lens and the screen until a clear image of the object is projected onto the
screen. Considering Eq. 22.1, how many combinations of di and do are possible?
3. Sketch the diagram shown in Fig. 22.7. Record
the position of each device: O, L, i. Positions are
measured directly from the optics bench; a line is
scribed on each holder for accuracy.
4. Calculate do , di , and f (Eq. 22.1).

O:

do :

do = L − O

(22.4)

di = i − L

(22.5)

L:

i:

di :

f=
Figure 22.7: Sketch required for all arrangements in
Part 1 and Part 3.
O is the position of the object.
L is the position of the lens.
i is the position of the image.
do is the calculated object distance (absolute value).
di is the calculated image distance (absolute value).

5. Hold lenses carefully by the edge. Project the image
of a distant object on a screen. One way to achieve
this is to take the lens and a ruler to a long hallway. Hold the lens such that light from a distant
light source at the other end of the hallway passes
through the lens and focuses on the wall.
6. Adjust the distance between the lens and the screen
until a clear, distinct image of the distant light
source is projected onto the screen.
7. Measure the distance from the lens to the screen.
This distance is f , as shown in Fig. 22.3. Eq. 22.1
shows that when do is large, di → f .
8. Is the image inverted? Magnified? Reversed?
9. Compare f (average) from the two methods.
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PART 2: Diverging Lens
To determine the focal length of a diverging lens,
the lens must create a measurable, real image as in
Part 1. However, light cannot be focused through
a diverging lens to form a real image unless that
light was already converging. To accomplish this, a
real image from a converging lens will be used as a
virtual object.2

Converging Lens:
O:

L:

i:

do :

di :

10. Form a real image using a converging lens. Note:
do should be greater than 2f .
11. Begin your required sketch (Fig. 22.9).
12. Place the diverging lens between the converging lens
and its (real) image; refer to Fig. 22.8. The real image from the converging lens is now a virtual object
for the diverging lens.

Diverging Lens:

13. Determine the position of the diverging lens’ image
by adjusting the screen’s position.

do :

L:

O:

i:
di :

f=
Figure 22.9: Sketch required for Part 2.
14. Complete your sketch (Fig. 22.9).
15. Determine do and di for the diverging lens.
16. Calculate f for the diverging lens.
Compare f of a Diverging Lens
17. Recalculate f using the following equation:
f=

VW
V −W

(22.6)

where V and W are defined as:
V ≡ |do |

and

W ≡ |di |

18. Compare f values from Eq. 22.1 and Eq. 22.6 for the
diverging lens. If you followed the sign conventions
closely, the f values should be identical.
Figure 22.8: Diverging Lens Arrangement

2 For

19. Remove the diverging lens; set it carefully aside.

a diverging lens, either the object or the image can be real; the other must be virtual.
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PART 3: Lateral Magnification, M
Use only the converging lens to investigate lateral
magnification. Remember to sketch all arrangements as in Fig. 22.7.
20. Set do > 2f by adjusting the distance between the
object and the lens. Find the image using your large
screen. Record the position of the image and mark
on the screen the top and bottom of the image.
21. Measure the image height, hi , and the object height,
ho . Be sure to measure the same dimension on both
object and image.
22. Calculate M :

M=

hi
ho

(Eq. 22.2)

23. Verify the magnification (M ) using the following
equation:
i
(Eq. 22.3)
M = −d
do
24. Compare the two values of M .
25. Set f < do < 2f . Locate the image.
26. Measure hi and ho .
27. Calculate M using Eq. 22.2.
28. Calculate M using Eq. 22.3.
29. Compare the two values of M .
30. Set do = f . Try to find di . Consider Method II
and Eq. 22.1; where should the image be?
31. Set do < f . Look through the lens at the object.
Note your observations.

PART 4: Equipment
32. Set the lens carefully aside where it will not be damaged.
33. Unplug the light source and lay the power cord
across the optics bench.

QUESTIONS
1. Draw ray diagrams for Method I and Method II
(Part 1, converging lens).
2. Consider a concave lens made out of air that is immersed in water (perhaps two watch glasses glued to
each end of a piece of pipe, with air inside). Will it
form a real image that can be focused on a screen?
Draw a ray diagram to support your answer.
3. If a convex lens with n = 1.30 and f = 25 cm is
immersed in a fluid with an index of refraction that
is also 1.30, what is the new focal length of the lens?
Draw a ray diagram.
4. What are the major sources of uncertainty in this
experiment?
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Experiment 22: Thin Lenses

Experiment 23: Wave Optics

Figure 23.1: Diffraction and Interference
Not to scale: For optimal measuring, distance between
the slide holder and measuring surface should be at least 1 meter.
EQUIPMENT
Laser
Black Felt
Single-Slit Slide
Double-Slit Slide
Slide Holder
Meter Stick
Vernier Caliper
Clipboard, Paper (Screen)
(1) Flashlight per person
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Experiment 23: Wave Optics

Figure 23.2: Intensity vs. Angle (Diffraction; Single-Slit)
Note the central envelope of the diffraction pattern. It is about twice the width of the envelopes on either side. The
pattern repeats with decreasing intensity (dimmer) as the angle increases left or right of θ = 0◦ .
“W ” is measured from the center of the dark to the center of the dark on either side of the central envelope.
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Figure 23.3: Intensity vs. Angle (Interference, Double-Slit)
Note the interference pattern (bright/dark fringes) contained within the envelopes of the diffraction pattern. The
central envelope is about twice the width of envelopes on either side. The patter repeats with decreasing intensity
as the angle increases left or right of θ = 0◦ .
“m” is the order number of each bright fringe. m equals zero when θ = 0◦ ; m is symmetric about θ = 0◦ . You will
make a mark through the center of each bright fringe in the central envelope. There is, of course, an odd number of
fringes in the central envelope. Use Eq. 23.4 to determine m for calculations of λ.

Experiment 23: Wave Optics

136
Advance Reading

Double-Slit Interference

Text: Wave optics, wavelength, frequency, electromagnetic spectrum, diffraction, interference, principle of
superposition.

When coherent light (e.g., laser light) passes through
two narrow slits that are close together, an interference pattern will result. The two slits are treated as
if they are two points sources of coherent light. This
pattern results from the addition and cancellation of
light waves from the two slits, known as constructive
and destructive interference, respectively. The resulting bands of light (conversely, bands of darkness) are
referred to as bright fringes (or dark fringes).

Objective
The objective of this experiment is to study diffraction
and interference and to determine λ, the wavelength of
the laser light.
Theory
Single-Slit Diffraction
Light passing through a narrow slit (slit width, D)
will produce a diffraction pattern. The diffraction pattern consists of a series of light and dark bands, or
envelopes.
Fig. 23.2 shows a plot of the light intensity vs. angle in
the diffraction pattern. The slit width, D, is provided
on the slide; δD = 0.005 mm. We use the small angle
approximation to derive Eq. 23.1; this method requires
angles in radians. The central bright envelope of the
diffraction pattern subtends an angle of 2φ, where:
φ=

λ
D

(23.1)

and λ is the wavelength. The angle will not be measured directly. φ can be determined by first measuring
the distance from the slit to the screen (L), then measuring the width of the central envelope, marked as W
in Fig. 23.2.
W
2 tan φ =
(23.2)
L
Using substitution, Eq. 23.1 and Eq. 23.2 are solved
for λ, in terms of quantities that can be determined in
the lab: W , D, L. The distance L should be at least
1 m for both diffraction and interference procedures.

Figure 23.4: Double Slit - Path Length Difference
Constructive interference occurs when the path length
difference, δ, is equal to an whole number of wavelengths (i.e., even number of 21 -wavelengths). Destructive interference occurs when δ is an odd number of
1
2 -wavelengths.
Constructive interference occurs when δ = mλ. Path
length difference is necessarily: δ = d sin θ, where d is
slit spacing.
δ = d sin θ = mλ

(23.3)

where m = 0, 1, 2, . . . , with m = 0 being the central maximum fringe. The fringe order number can be
found by counting the number of fringes:
m=

#f ringes − 1
2

(23.4)

For small angles measured in radians, the small angle
approximation (refer to Experiment 11) is useful:
sin θ ≈ tan θ = y/L

(23.5)

Using substitution, Eq. 23.3 and Eq. 23.5 are solved
for λ, in terms of quantities that can be determined in
the lab: m, d, y, L.
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Name:
1. Define diffraction. (10 pts)

2. Define interference. (10 pts)

3. What does the symbol D in Eq. 23.1 represent? (10 pts)

4. What does the symbol d in Eq. 23.3 represent? (10 pts)

5. Use substitution to solve the single-slit equations (Eq. 23.1 and Eq. 23.2) for λ, in terms of the quantities that we
will determine in lab: W , L, D. (20 pts)

6. Use substitution to solve the double-slit equations (Eq. 23.5 and Eq. 23.3) for λ, in terms of the quantities that
we will determine in lab: m, L, d, y. (20 pts)

7. Given D1 = .02 mm and δD = .005 mm, calculate δ% D1 . Given D2 = .16 mm, calculate δ% D2 . Why will it be
important to begin with the widest slit? (20 pts)
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PROCEDURE
PART 1: Single-Slit Diffraction
1. Place the single-slit slide on the slide holder. Align
the slide holder in front of the laser aperture.
2. Set up the clipboard and paper in front of the
laser, at least one meter away from the slide holder.
Record this distance, L.
3. Turn on the laser to create a diffraction pattern
on the clipboard. Begin with the widest slit. Slit
width is provided on the slide; its uncertainty is
δD = ±0.005 mm.
4. Mark the width, W , of the central band. Measure
from the center of the dark bands on either side.
Take measurements in a tidy manner, use extra paper as needed.
5. Close the shutter. Calculate λ; show your work.
[The mathematical model uses radians.]
6. Repeat for the three remaining slits. Calculate average λss for the single-slit procedure.

Experiment 23: Wave Optics
PART 2: Double-Slit Interference
7. Place the double-slit slide on the holder. Turn on
the laser. Begin with the widest spacing.
8. Mark a line through each of the bright fringes in the
central bright envelope. The distance between the
outermost fringes is 2y.
9. Close the shutter. Determine 2y and m.
10. Calculate λ. Show your work.
11. Repeat for the remaining pairs of slits. Calculate
average λds for the double-slit procedure.
12. Calculate the total average λ from your measurements. Compare this to the laser’s theoretical wavelength: λ = 6328 Å [Å=10-10 m]. Show your work.

QUESTIONS
1. Explain and compare diffraction and interference.
2. What are the sources of uncertainty in this experiment?

Appendix A: Math Review
A great deal of information can be obtained by first considering the type of equation being investigated.
• Is one variable squared? If yes → it is a quadratic equation.
• Are there trigonometric functions in the equation? If yes → it is a sinusoidal equation (or tangential, or . . . ).
• Is there an exponential (i.e., the number “e,” not an exponent) in the equation? If yes → it is an exponential
equation.
• If none of the above, is this equation linear? If yes → use the slope-intercept equation of a line: y = mx + b.

Consider the kinematic equations below (from Experiment 4: Projectile Motion).

x = x0 + v0x t + 21 ax t2

Quadratic in Time

y = y0 + v0y t + 12 ay t2

Quadratic in Time

vx = v0x + ax t

Linear

vy = v0y + ay t

Linear

vx2 = v02x + 2ax (x − x0 )

Quadratic in Velocity

vy2 = v02y + 2ay (y − y0 )

Quadratic in Velocity

We will use other types of equations this year as well:

FB = ILB sin θ

Magnetic Force is Sinusoidal as the Angle Varies

N − N0 eλt

Exponential Growth (Your calculator has the function e.)
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General Physics requires mastery of college-level algebra and trigonometry.

If it has been some time since you used this level of math, it is important that you refresh your knowledge and skills.
Your text for physics lecture may have a math appendix; if it does, please read through it to be certain you have the
math knowledge required.
This appendix is a simple summary of math that is frequently used in General Physics Lab. Some experiments will
require more advanced knowledge.
Solve for x means that the variable x is on one side of the equation, everything else in the equation is on the other
side. If x is the only variable, the equation has a unique solution (has only one correct answer).
If unique solutions are required, the number of unknowns must equal the number of equations.
Consider the equation for the circumference of a circle: C = πD. There is 1 equation and 2 unknowns; there is no
unique solution. Refer to Fig. A.1. Any point on the line is a correct solution. There are an infinite number of
correct solutions.

Figure A.1: Linear Plot
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Solving 3 equations with 3 unknowns is required in lab. The variables are the unknowns.
There are various methods for solving a system of equations, many using advanced linear algebra of computing
software, but the simplest and most straightforward is the substitution method, covered below:
Note that this method applies to any set of x equations with x unknowns, the procedure simply requires more or fewer
repetitions, you will solve 2 equation 2 unknown type problems repeatedly, and abundantly in this course.
Choose one of the equations; if all 3 equations have all 3 unknowns, it does not matter which one you choose first.
If this is not the case, remember you need to eliminate and unknown! Choose the equation that has all 3 unknowns.
Designate this equation as Eq. 1. Solve Eq. 1 for one of the unknowns (it does not matter which one).
Substitute Eq. 1 into a second equation; designate this second equation as Eq. 2.
Note that the substitution must eliminate an unknown.
Designate the last equation as Eq. 3.
You now have 2 equations with 2 unknowns: Eq. 2 and Eq. 3.
Choose either Eq. 2 or Eq. 3, then solve it for an unknown;
Substitute the value of this unknown into the remaining equation.
Note that the substitution must eliminate an unknown.
You now have 1 equation and 1 unknown.
Solve the equation; substitute this value into the previous equation.
Solve the equation; substitute this value(s) into the first equation.
Solve the first equation. Done. Check your answer.
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Example for “Solving 3 Equations with 3 Unknowns”
Given the following 3 equations, solve for x, y, and z:
x=y+z
1.5 − 3x − 4z = 0
−1.5 − 5y + 6z = 0
Choose the equations that has all 3 unknowns.
Designate this equation as Eq. 1. Solve Eq. 1 for one of the unknowns: z.
Eq 1: x = y + z → z = x − y

Substitute Eq. 1 into a second equation; designate this second equation as Eq. 2.
Eq. 2: 1.5 − 3x − 4z = 0 → 1.5 − 3x − 4(x − y) = 0 → 1.5 − 7x + 4y = 0
Choose Eq. 2 or Eq. 3, then solve it for an unknown: Eq. 2.
Eq. 2: 1.5 − 7x + 4y = 0 → x = (1.5 + 4y)/7
Substitute the value of this unknown into the remaining equation:
Eq. 3: −1.5 − 5y + 6x = 0 → −1.5 − 5y + 6( 1.5+4y
)=0
7
Solve the equation:
−1.5 − 5y +

9
7

+

24y
7

=0→

24y
7

− 5y = 1.5 −

9
7

→

−11y
7

=

3
14

3
→ y = ( −7
11 )( 14 ) = −0.136

Substitute this value into the previous equation and solve the equation:
Eq. 2: x =

1.5+4y
7

→x=

1.5+4(−0.136)
7

→ x = 0.137

Substitute these value(s) into the first equation and solve the equation:
Eq. 1: z = x − y → z = 0.137 − (−0.136) → z = 0.273
Done. Check your answer!

Appendix A: Math Review

143

Solving a quadratic equation is easily accomplished by the use of the quadratic formula.
A quadratic means that one variable is squared.
To use the quadratic formula, the equation must first be in the correct form: ax2 + bx + c = 0.
The coefficients are a, b, and c; a 6= 0.
The coefficient of x2 is a, the coefficient of x1 is b, the coefficient of x0 is c.
√
−b± b2 −4ac
The quadratic formula is x =
.
2a
7x2 − 3x = 5 is a quadratic equation. 7x2 − 3x − 5 = 0 is the required form to use the quadratic formula.
The coefficients for this equation are a = 7, b = −3, and c = −5.
To use the quadratic formula, substitute the coefficients (i.e., a, b, c) into the formula.

x=

−(−3)±

√

9−(4)(7)(−5)
(2)(7)

Solve the equation. Note that a quadratic equation will always have 2 solutions. An equation involving a variable
raised to any power n has n solutions. For example: y = x7 , n = 7. There are 7 solutions.
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Trigonometry

An angle is measured from the +x-axis, in a counterclockwise direction unless specified otherwise.

Figure A.2: Cartesian Graph
The sum of the angles of any triangle equals 180◦ . 180◦ = π (radians).
The Pythagorean Theorem states that a2 + b2 = c2 ; we often use other variables: x2 + y 2 = r2 (refer to Fig. A.3).

Figure A.3: Right Triangle
Note that the cos θ = sin α, etc.
Note that to solve a trig function for an angle, you must take the inverse of the trig function.
When using a calculator to determine the inverse tangent of an angle, your calculator may give you an angle that
is in the wrong quadrant [calculated angle will only be in quadrant I (+θ) or quadrant IV (−θ)]. To determine the
correct quadrant, consider the ± sign of the argument: If x is negative, the angle must be in quadrant II or III; if y
is negative, the angle must be in quadrant III or IV. If both x and y are negative, the angle must be in quadrant III
(refer to Fig. A.2).
If the calculated angle is in the wrong quadrant, simply add 180◦ to the calculated angle.
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If an angle is measured in radians, the arc length s equals the radius r times the angle θ (refer to Fig. A.4).

Figure A.4: Arc Length

Figure A.5: Small Angle Approximation

If an angle is small and measured in radians: sin θ ≈ tan θ ≈ θ (refer to Fig. A.5).

Consider a circle of radius r (refer to Fig. A.6).
The circumference C of the circle is C = 2πr.
The area A of the circle is A = πr2 .

Figure A.6: Circle of radius r

Consider a right-circular cylinder of
radius r and height h (refer to Fig. A.7).
The volume V of the cylinder is V = πr2 h.

Figure A.7: Right-Circular Cylinder
radius r, height h
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Name:

Section

Be careful to read the instructions, show your work, and include units as necessary. Use the symbols specified. No
partial credit for math exams. One point (1 pt) per question.
Solve each equation for x:
1. y = 7x − 6 + 2x
2. 5x = 2x − 7 + y
3. 3x2 − 4 = x

4. Solve for x and y (2 equations with 2 unknowns) using substitution:
2x + y = 3
y − 2x = 9

Consider a sphere of radius r.
5. V =

(volume)

6. A =

(surface area)

Consider a circle of diameter D.
7. C =

(circumference)

8. A =

(area)

Refer to Fig. A.8 for questions 9 through 11:
9. V =
10. C =
11. A =

(volume)
(circumference)
(surface area)

Figure A.8: Solid Right-Circular Cylinder
height h, radius r.
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12. Consider a triangle. How many degrees and radians are there?
degrees

radians

Refer to Fig. A.9 for questions 13 through 19. Answer in terms of x, y, and r.

13. Pythagorean Theorem:
14. cos α =
15. sin β =
16. sin α =
17. cos β =
18. tan α =
Figure A.9: Right Triangle

19. tan β =

Simplify the following expression:
20. 9z + 3 − 7x + 2z − 3x − 8 + 5z − 3y
Convert the following:
21. 55 mph =

m/s

22. 162.56 cm =
23. 1 cm3 =

ft’ in” (e.g., 6’1”)
m3

Use the quadratic formula to solve the following equation:
24. 9x2 + 7x = 2
25.

√

x = x to the power
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Appendix B: Measurement and
Uncertainty
GENERAL INFORMATION
Every measurement has some uncertainty. These uncertainties are called errors. “Error analysis is the study and
evaluation of uncertainty in measurement.”1 Measurements are usually made against some standard to compare the
object or quantity being measured with some known value. For instance, if the length of a table is measured with a
meter stick, the table is being compared to the meter stick, but the meter stick is also referenced to some standard.
It is important to keep in mind that any “known” value given as a standard has an uncertainty associated with it.
Any measurement you make has an uncertainty associated with it as well.
Error analysis is an interesting and complex subject. As an introduction to this topic, certain experiments will
focus on particular types of analysis: statistical analysis, uncertainty of measurements, and propagation of error
(propagation of uncertainty). The details follow.
Significant Figures
There are rules for significant figures (lab manual: Experiment 1 and Giancoli : Chapter 1, Section 4). All data should
be recorded with the proper number of significant figures in your lab notebook as well as in your lab reports. To
prevent rounding errors, keep one more significant figure than is justified until you are finished with your calculations.
Accuracy and Precision
An important consideration in research (laboratory) is the accuracy and the precision of a measurement. Commonly, these two terms are used as synonyms, but they are quite different. The accuracy of a measurement is how
close the measurement is to some “known” value (how small the percent error is; related to systematic and personal
error). For instance, if an experiment is performed to measure the speed of light, and the experimental value is very
close to the known (accepted) value, then it can be said that the value is accurate. On the other hand, the precision
of an experiment is a measure of the reproducibility of an experiment (related to random error).
When performing an experiment, one needs to keep in mind that a measurement that is precise is not necessarily
accurate and vice versa. For example, a vernier caliper is a precision instrument used to measure length (the resolution
is 0.005 cm). However, if a damaged caliper is used that reads 0.25 cm too short, then all of the measurements would
be incorrect. The values may be precise, but they would not be accurate.

1 Taylor,

John R., “An Introduction to Error Analysis”, University Science Books, Mill Valley, CA, 1982.
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EXPERIMENTAL ERRORS
Experimental errors are generally classified into three types; systematic, personal, and random. Systematic errors
and personal errors are seldom valid sources of uncertainty when performing an experiment as simple steps can be
taken to reduce or prevent them. You will need to discuss “sources of uncertainty” for each experiment when you
write a full lab report. Assume you performed the experiment correctly using calibrated equipment. Useful questions
to ask yourself for this section of the report are what is “wrong” with the method (errors inherent in the method)
and what assumptions are made that are not valid? The specifics follow for types of experimental errors.
Systematic Error
Systematic errors are such that measurements are pushed in one direction. Examples include a clock that runs
slowly, debris in a caliper (increases measurements), or a ruler with a rounded end that goes unnoticed (decreases
measurements). To reduce this type of error, all equipment should be inspected and calibrated before use.
Personal Error
Carelessness, personal bias, and technique are sources of personal error. Care should be taken when entering values
in your calculator and during each step of the procedure. Personal bias might include an assumption that the first
measurement taken is the “right” one. Attention to detail and procedure will reduce errors due to technique.
Parallax, the apparent change in position of a distant object due to the position of an observer, could introduce
personal error. To see a marked example of parallax, close your right eye and hold a finger several inches from your
face. Align your finger with a distant object. Now close your left eye and open your right eye. Notice that your
finger appears to have jumped to a different position. To prevent errors due to parallax, always take readings from
an eye-level, head-on perspective.
Random Error
Random errors are unpredictable and unknown variations in experimental data. Given the randomness of the errors,
we assume that if enough measurements are made, the low values will cancel the high values. Although statistical
analysis requires a large number of values, for our purposes we will make a minimum of six measurements for those
experiments that focus on random error.
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COMPARISON of EXPERIMENTAL VALUES
Percent Error and Percent Difference
We frequently compare experimental values with accepted values (percent error ), and experimental values with other
experimental values (percent difference).
Accepted Values might be found in tables (e.g., g = 9.80 m/s2 , c = 3.0 × 108 m/s, π = 3.14), or calculated from
equations that assume ideal conditions. This is a measurement of accuracy.
Experimental Values: We often use more than one method to determine a particular quantity in lab, then compare
the values, or compare a particular value with the class average. This is a measurement of precision

When comparing values, use the following equations:

% error =

% difference =

|accepted − experimental|
× 100
accepted

|value1 − value2 |
value1 +value2
2

× 100 =

|value1 − value2 |
× 100
valueavg

These values are rounded to one or two significant figures, determined by the following:
• Keep only one significant figure unless the value begins with the number one.
• Keep two significant figures if the value begins with the number one.

(B.1)

(B.2)
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Appendix C: Computers and Software
iMac OPERATING INSTRUCTIONS
To TURN ON your computer, push the power button; it’s on the left back side, near the bottom.
The Command (used for keyboard shortcuts) key is on each side of the space bar.
To Select something on a computer means to click on it once with the mouse.
To Open software, a file, or a folder, double-click on it with the mouse cursor.
To Close software: click on the Software Title ⇒ Quit
[Command + Q]
To Close a document or folder : FILE ⇒ Close Window
[Command + W]
To Re-size a document, click and drag the bottom right corner of the window.
To Collapse (minimize) a window, click on the software title, select Hide
[Command + H]
To Switch between different programs, move your mouse cursor to the Dock (the dock is at the bottom of your
computer desktop). Icons for all open software will be displayed. Select the needed software.
To TURN OFF the computer: Apple Icon (top left of computer desktop) ⇒ Shut Down ⇒ Shut Down
When you have finished your experiment:
• ALWAYS close all software: Software Title ⇒ Quit ⇒ Don’t Save

[Command + Q]

• Note that closing the software window is not sufficient when using an iMac.
• Close all folders; shut down the computer.
LOGGER PRO Software
Always be certain that Lab Pro is connected before you open Logger Pro software. Connect Lab Pro to the computer
using the USB cable; do not connect it to the keyboard
• Sensor(s) - motion detector: DIG/Sonic 2 port; force sensor: CH 1, ±50 N; thermistor: CH 1
• Power supply; plug the power supply into an electrical outlet
If you need to confirm the sensor you are using, a window will open automatically. On the right side of the window,
specify the “Interface & Channel” being used, then specify the sensor. Click on “Connect.”
To open Logger Pro software, open the following folders on your computer:
Software ⇒ Logger Pro 3 ⇒ Experiments ⇒ Physics with Vernier (Exp 14: Heat, open the “Physical
Science with Vernier” folder.)
Then open the specified experiment that is needed for the experiment you are performing.
If you print graphs from this software, File ⇒ Page Setup: Orientation: Landscape; File ⇒ Printing Options: Enter
team names as needed.
When finished with the experiment, close the software: Logger Pro ⇒ Quit ⇒ Don’t Save, then close the folders and
disconnect all Lab Pro equipment. Turn off the computer.
If software or computer problems develop, close the software, then open it again. If problems persist, close the
software, restart the computer, then open the software again. If this fails, ask your TA for help.
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GRAPHING

Consider the slope-intercept equation of a line: y = mx + b. If b = 0, the equation reduces to y = mx. When you
graph “y vs. x ” and produce a linear (straight line) graph, the slope, m, of the graph is the constant of proportionality.
The y-axis is the ORDINATE (dependent variable). The x-axis is the ABSCISSA (independent variable).
Consider two proportional quantities, A and B. Graphing A vs. B is equivalent to graphing y vs. x. The resulting
linear graph has slope m, which represents the constant of proportionality. When investigating linear functions, if
x = 0 and y = 0, then b = 0. When this is true, (0,0) is a relevant and necessary data point. Always determine if
the data point (0,0) is necessary.
A nonlinear graph is a curve(s); it is not a straight line. Note that a curve does not have a single slope, it has a
constantly changing slope (an infinite number of slopes). Always determine if (0,0) is necessary.
A properly drawn graph must have the following components:
• Title

• Axes Labels with Units
• Appropriate Scale

• Appropriate Analysis (refer to Fig. C.3)

• Error Bars (not if graphs are produced by hand)

• Mathematical Analysis after the graph is printed
• Team Names and Date
Graphing by Hand
When plotting your data, you will need to determine the scale based on the range of values. Always choose easily
divisible increments for the major divisions (e.g., 2, 5, 25). Your plot should fill most of the graph (refer to Fig. C.1
and Fig. C.2). The same data is plotted on both graphs; only the scales have changed.
Use a best fit connecting line when analyzing your graph; do not “connect the dots.” A best fit line will have about
as many data points above the curve as below. If the plot is linear, a ruler should be used.
For example, assume you are graphing distance vs. time. If your distance values range from 0 m to 40 m, your y-axis
should span 0 to 40 meters, perhaps up to 50 m. If your time values range from 0 to 80 seconds, your x-axis should
span from 0 to at least 80 s. Refer to Fig. C.1.

Figure C.1

Figure C.2
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Graphing with Graphical Analysis
Quick Start (most of what you will do in this lab)
In order to enter multiple data sets into Graphical Analysis, click the Data drop down at the top ⇒ New Data Set
If you label the columns, those labels will appear on the axis. Double click the column name, and rename them.
To get your new data to appear on the graph, double click on the graph ⇒ click Axes Options ⇒ Under Y-Axis
Columns, select each Y column (you may need to click the drop down arrow next the name for each data set.) You
are selecting which columns to graph on the Y-Axis, so do not select the X values!
To title the graph, double click anywhere on the graph, and enter the title into the box that appears.
In Depth Guide to Graphical Analysis
Graphs for physics lab required Graphical Analysis software. The software is available at no charge for physics
students to install on their home computer. The required username is “physics.” The password is “physicslabs.”
Download and install the software on your home computer. To obtain the software, go to the link on your Lab
Physicist’s website or:
http://www.phy.olemiss.edu/Courses/Software/
If you do not have your own computer, you may need to use public computers; you might need to “Run” the software
from the website rather than “Download ” the software. Weir Hall, Honors College, and UM Library have the software
installed for your use on the student computers. Be certain you can print from the computer you are using! Printing
is not available for students in the Department of Physics and Astronomy.
Analysis of Graphs
To analyze your graph, fit your data to a general equation, and match up the parts to a known function. A general
equation has the main elements of a particular type of function (equation). The variables used in the general equation
can represent many quantities, thus the name. The known function is easy to determine: What is the equation for
the concept or theory you are investigating? To match up the parts of the two equations, write one below the other
and connect the corresponding parts with a line (match up the parts). To determine the type of general equation
you need, consider the following questions:
• Is one variable squared? If yes → it is a quadratic equation.
• Are there trigonometric functions in the equation? If yes → it is a sinusoidal equation (or tangential, or . . . ).
• Is there an exponential (i.e., the number “e,” not an exponent) in the equation? If yes → it is an exponential
equation.
• If none of the above, is this equation linear? If yes → use the slope-intercept equation of a line: y = mx + b.
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General Equation ⇐⇒ Known Function Examples

Consider the equation for the circumference of a circle, C = πD. Plot “C vs. D” (C on the y-axis, D on the x-axis).

If b = 0, the slope m equals everything else in the equation, in this case, the number π.
Consider an equation for exponential decay: N (t) = N0 · e−λt . N is the number of particles as time progresses; N0
is the initial number of particles. e(−λt) can also be written “exp −λt.” Plot “N vs. t,” and analyze the graph:
We want to know λ (lambda), a coefficient that represents the rate of decay.
B = 0.
The “Information Box” will provide a value for the coefficient “C,” which is equal to λ.

Most of the graphs we analyze are linear. When nonlinear graphs are analyzed, follow the same process: Match up
parts of the two equations (general and known function).
Graphical Analysis has many built-in general equations but not all. You may need to enter (type) the general
equation if it is not available; the general equation will be given by the TA or in the procedure if needed.
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The Data
Data ⇒ (Take care of data details before graph details.)
Data Set Options ⇒
Name the data set; keep it short.
Column Options ⇒
Select each data column and fill in the relevant information. Note that often tabs are available that open additional
windows. The style of the point protector must always be “Empty” rather than “Filled.” When uncertainties need
to be entered, refer to “Error Bar Calculations.”
Enter The Data ⇒
When entering data that have multipliers: e.g., 3.1 cm = 3.1 × 10−2 m = 3.1 E-2 m, type: “3.1 e - 2.”
When entering angle measurements in degrees, Select File ⇒ Settings for Untitled ⇒ Change the unit to degrees.
If you have multiple sets of data, Select Data ⇒ New Data Set
The software will calculate a new data set for you: Data ⇒ New Calculated Column ⇒ Enter the necessary information.
The Graph
Options ⇒ (Click once on the graph to make it the active field.)
Graph Options ⇒
Fill in the relevant information. Except for Experiment 15: Ohm’s Law, never select “Connect Points” as we will fit
data to known functions. When more than one data set is plotted on a single graph, you must enter the label and
unit for the y-axis.
Specify the column(s) of data to be plotted on the y-axis as well as the column of data to be plotted on the x-axis.
Do not use the “Right Y-Axis.”
The Analysis (1st Step)
Analyze ⇒ Curve Fit ⇒
Select the relevant data set ⇒ Select the general equation ⇒ Try Fit ⇒ OK; or
Select the relevant data set ⇒ Define Function ⇒ Type the general equation ⇒ Try Fit ⇒ OK.
We will use “Curve Fit” for all graphs, even if they are linear. The value of all quantities in the general equation is
specified in the “Information Box” that will appear on your graph for each data set that you analyze.
The Printing
File ⇒
Page Setup ⇒ Always landscape.
Printing Options ⇒ Enter names, Date, Page Title, Page Number
File ⇒ Print Graph (Never use the print icon or File ⇒ Print)
File ⇒ Print Data Table (if needed)
The Analysis (2nd Step)
On the graph, in ink, write the general equation and, below it, the known function being investigated.
Match parts of the general equation to the corresponding parts of the known function.
Refer to the “Information Box” on the graph. The value of the unknown quantity can be determined, although it
may require some algebra. Calculate the necessary quantities. Refer to Fig. C.3.
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Figure C.3

General Equation:

Mathematical analysis is
required for every graph of
known functions.

Known Function:

The software performs the
1st step of analysis.
You complete the analysis
after printing.

Match parts of the general equation to corresponding parts of the known function.
Current, I, is plotted on the y-axis; electric potential difference, V , is plotted on the x-axis (I vs. V ).
The slope m equals everything else in the equation, in this case, inverse of the resistance, R.
Note that 6 of the 7 required graph components are present in this figure.
When you Print Graph, the team names and date will print (7th graph component).
Note that the software does the first step in the analysis. After the graph is printed, you must complete the analysis.
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Figure C.4: Data Table
You are usually required to print your data: File ⇒ Print Data Table. . .
Set the printing parameters prior to printing.
Note: Use Column Options to name each data set, name each column of data, enter the unit for each column of
data, and the uncertainty of the measurement (error bar calculation) before you enter the data. Two (2) data sets
are on this data table. Note that:
• Each data set is named
• Each column of data is named
• Unit symbols are entered
• Error Bars (uncertainty of measurement) have been entered; (uncertainties appear only on the graph but only
if “empty” geometric figures, such as an empty circle, are chosen)
• If the uncertainty of measurements varies, enter the uncertainty for each measurement in a new column: Data
⇒ New Manual Column. Be sure to set all the parameters (name, unit) for the column of data. Now return to
the measurement column of data, Options tab, Select “Error Bar Calculations,” and specify the appropriate
column of data to use for the uncertainty of those measurements

